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Diferente do projeto de sistemas digitais, no qual as técnicas de projeto e 
ferramentas CAD vêm apresentando uma crescente evolução acompanhada da redução 
de seus preços, o projeto de sistemas analógicos CMOS ainda apresenta uma forte 
correlação com a experiência do projetista. Dentro deste contexto, importantes fatores 
como caracterização de tecnologia, modelamento de dispositivos e metodologia de 
projeto devem ser considerados. 

Este trabalho apresenta um estudo destes importantes fatores necessários para se 
realizar o projeto de um sistema analógico com menor custo, bom desempenho e 
reduzido tempo de projeto. Primeiramente, é necessária uma extensa caracterização da 
tecnologia CMOS a ser usada, onde os parâmetros que descrevem as caracteristicas 
elétricas dos dispositivos são obtidos. A partir desta caracterização e das especificações 
requeridas para o circuito, é feita uma modelagem e síntese a fim de se obter as 
dimensões dos transistores. Ferramentas para a análise do desempenho elétrico são 
utilizadas a seguir, antes de se realizar a descrição geométrica (layout) do circuito. Com 
o layout pronto, uma nova simulação elétrica é feita incluindo os efeitos geométricos, 
incluindo-se os parasitas R, C e L extraídos do layout. Se os resultados forem 
satisfatórios, o circuito está pronto para fabricação; havendo degradação do desempenho 
esperado, uma nova iteração de projeto é realizada. 

Mais especificamente, este trabalho ilustra o processo de análise de vários 
circuitos analógicos, assim como as caracteristicas de cada circuito em questão, 
empregando diferentes metodologias de projeto. Uma metodologia de projeto 
convencional, baseada em modelos onde se obtém uma equação explícita para a 
corrente válida na região de operação de saturação do transistor, e uma metodologia de 
projeto baseada na caracteristica g,/ID do transistor, que apresenta uma síntese 
unificada, considerando todas as regiões de operação do transistor MOS. 

Os circuitos a serem analisados e projetados neste trabalho são blocos 
considerados básicos para construção da maioria dos sistemas analógicos usados 
atualmente, como, por exemplo, Moduladores Sigma-Delta. Tais blocos são 
amplificadores, comparadores e filtros analógicos. A metodologia de projeto, baseada 
em parâmetros do modelo elétrico, é apresentada, enfatizando a caracteristica ~ ,LD do 
transistor. Simulações elétricas serão realizadas (esquemático e layout extraído) para 
cada bloco, validando-se o projeto para as especificações requeridas. 

Palavras-chave: Projeto analógico CMOS, modelamento, simulação elétrica, 
caracterização de parâmetros, metodologia de projeto, microeletrônica. 



TITLE: "ANALYSIS AND DESIGN OF AMPLIFIERS AND COMPARATORS 
MODULES IN CMOS 0.35pm TECHNOLOGY' 

Abstract 

Design techniques and CAD tools for digital systems are advancing rapidly at 
decreasing cost, while CMOS analog circuit design is related mostly with the individual 
experience and background of the designer. Therefore, the design of an analog circuit 
depends on several factors such as a reliable design methodology, good modeling and 
circuit fabrication technology characterization. 

This work presents a study of these factors that allow an analog system to be 
designed with high quality and performance at low cost, in a reasonable design time. 
First, an extensive characterization of the technology must be developed, where a11 the 
parameters that describe the electrical properties of the device are obtained. When this 
task is complete, an extensive analysis and modeling is made, transforming 
specifications into circuits with the transistor dimensions calculated. This leads to 
another important task - using electrical simulation to predict the performance of the 
circuit. Once the performance goals are satisfied, the designer is faced with the task of 
geometrical description (layout) of the circuit. Once the layout is finished, it is 
necessary to include the geometrical effects in a post-extraction simulation. If the results 
are satisfactory, the circuit is ready for fabrication. In case the specifications are not 
met, new design iteration must be undertaken. 

Most of this work focuses on the analysis of several analog circuits, including 
their functionality, using different design methodologies. A "conventional" design 
methodology, based on the modeling where a current equation is obtained considering 
that the transistor is in the saturation region, and a design methodology based on the 
gm/ID characteristic, that allows a unified synthesis methodology in a11 regions of 
operation of the transistor. 

The analog circuits to be analyzed and designed in this work are basic building 
blocks (amplifiers, comparators and analog filters) that find vast applications today, 
including an application of interest - Sigma-Delta Modulators. The design methodology 
based on the g,,lI~ characteristic, and the electrical device parameters related to them, 
are exercised in this work. In order to demonstrate this analysis, electrical simulations 
(schematic and extracted layout) of performance will be obtained for each block. 

Keywords: CMOS analog circuit design, modeling, electrical simulation technology 
characterization, design methodology. 



1 Introdução 

Um dos principais fatores na evolução no projeto de sistemas VLSI (Very Large 
Scale Integration) é a tecnologia de integração de circuitos que permite a realização e 
construção de sistemas cada vez mais velozes e complexos. 

Hoje é visível uma crescente digitalização dos sistemas, porém os circuitos 
analógicos não podem ser totalmente substituídos, Todas as grandezas físicas na 
natureza são analógicas, fazendo-se necessária alguma forma de transformar sinais 
analógicos em digitais e vice-versa. Muitas vezes, o processamento de um sinal por um 
circuito analógico é mais econômico e eficiente do que o seu equivalente digital. 
Exemplos dessa economia podem ser encontrados em aplicações onde a freqüência de 
operação é alta, inviabilizando sua implementação digital com sinal amostrado, ou em 
aplicações de baixa potência. 

Atualmente, circuitos integrados analógicos em tecnologia MOS (Metal Oxide 
Semiconductor) vêm sendo largamente utilizados em diversas aplicações. Além de 
possuir uma alta densidade de integração, esta tecnologia fornece uma alta 
confiabilidade e desempenho com um baixo consumo de potência. Reconhecendo estas 
caracteristicas únicas presentes em circuitos MOS, os projetistas analógicos vêm 
buscando a integração da parte digital com a parte analógica (projeto misto) em uma 
mesma pastilha de silício visando combinar as vantagens de ambos os lados, o que 
também aumenta a complexidade do projeto. 

Diferente do projeto de sistemas digitais onde as técnicas e ferramentas CAD 
(Computer-Aided Design) vêm apresentando uma crescente evolução acompanhada da 
redução de seus preços, o projeto de circuitos analógicos ainda apresenta uma forte 
correlação com experiência do projetista. O projetista deve entender profundamente 
aspectos importantes de projeto, como caracteristicas de processo e tecnologia, a fim de 
modelar, caracterizar, implementar e testar os seus circuitos. 

Dentro deste contexto, o modelamento de dispositivos semicondutores constitui 
um aspecto importante no projeto de um sistema analógico, pois de forma abstrata tem- 
se o objetivo de emular o comportamento elétrico de um dispositivo real durante a fase 
de projeto. Portanto, o modelamento e a caracterização de dispositivos MOS são áreas 
de constante pesquisa, tanto acadêmica quanto industrial. Muitas ferramentas 
computacionais têm sido desenvolvidas para estudar as caracteristicas do transistor 
MOS e emular o desempenho de circuitos formados por este dispositivo. Atualmente 
são utilizados simuladores de circuitos tais como o Spice, que adotam modelos 
compactos para a emulação do diversos dispositivos. Estes simuladores tomaram-se 
importantes na análise do desempenho elétrico de sistemas analógicos, alcançando uma 
posição de destaque no projeto K S I .  

Entretanto, o projetista de circuitos integrados analógicos deve considerar que o 
resultado da análise feita pelo simulador é tão aproximada quanto os modelos utilizados. 
Além dos modelos apresentarem imperfeições, existe uma inadequação dos parâmetros 
do modelo fornecido pelas foundries, por exemplo. Também as novas tecnologias de 
fabricação determinaram a necessidade de modelos capazes de simular efeitos elétricos 
relacionados á geometria reduzida (canal curto e estreito), já que os modelos que 
simulavam transistores MOS de canal longo tornaram-se inadequados para dispositivos 
de geometria reduzida. Além disso, as aplicações de circuitos analógicos e digitais em 
baixa tensão requerem modelos capazes de simular dispositivos MOS que operam na 
região de condução sub-limiar. 



Outro importante fator que o projetista analógico deve considerar é a 
metodologia de projeto a ser usada, ou seja, dadas as especificações desejadas, o cálculo 
da geometria dos transistores (WIL) dos blocos a partir de modelos analíticos que 
emulem o comportamento do bloco a ser implementado. A maioria dos métodos para 
sintese de circuitos analógicos geralmente considera que os transistores MOS operam 
em inversão forte ou em inversão fraca, o que muitas vezes não é uma boa solução para 
se obter resultados de um bom desempenho. 

Diversos trabalhos desenvolvidos no Grupo de Microeletrônica da UFRGS como 
[CHO 941 [CHO 20011 apresentam a análise de diversos sistemas analógicos utilizando 
metodologias de projeto diferentes. Porém viu-se a necessidade de um estudo focando 
as técnicas de análise e projeto de blocos analógicos básicos, considerando aspectos 
importantes como modelagem, caracterização e cálculo das dimensões dos transistores. 

Este trabalho tem como objetivo o estudo de técnicas de projeto e modelagem a 
fim de se obter um projeto de um circuito analógico com menor custo, bom desempenho 
e reduzido tempo de projeto. Serão discutidos os passos considerados essenciais para se 
obter um sistema analógico confiável: primeiramente, uma extensa caracterização da 
tecnologia a ser usada deve ser feita, onde os parâmetros que descrevem as 
caracteristicas particulares dos dispositivos são obtidos; a partir desta caracterização e 
das especificações requeridas para o circuito é feita uma modelagem e sintese a fim de 
se obter a dimensão dos transistores; a seguir usam-se ferramentas para a análise do 
desempenho elétrico do circuito; após isto, é feita sua descrição geométrica (layout); 
com o layout pronto, uma nova simulação elétrica é feita, incluindo os efeitos 
geométricos (parasitas extraídos do layout). Com todos estes passos feitos, se os 
resultados forem satisfatórios, o circuito está pronto para fabricação (havendo 
degradação do desempenho esperado, uma nova iteração de projeto deve ser realizada). 

Os circuitos a serem analisados são blocos considerados básicos para construção 
da maioria dos sistemas analógicos usados atualmente, mais precisamente visando 
Moduladores Sigma-Delta - amplificadores, comparadores e filtros analógicos. Toda 
esta análise será baseada na tecnologia AMS0.35pmLm, uma tecnologia de canal curto 
recente disponível para o uso acadêmico. 

O texto desta dissertação está organizado da seguinte maneira: 
No capítulo 2 é discutido com mais detalhe o projeto analógico CMOS, 

analisando suas caracteristicas de tecnologia, modelagem do transistor e caracterização 
de parâmetros de tecnologia. 

O capítulo 3 ilustra o processo de análise de vários subcircuitos analógicos, 
assim como as caracteristicas de cada bloco em questão, empregando uma metodologia 
de projeto convencional baseada nos modelos desenvolvidos anteriormente. 

O capítulo 4 apresenta uma metodologia de projeto baseada na característica 
g,,lI~ do transistor, uma metodologia de sintese unificada considerando todas as regiões 
de operação do transistor MOS. 

O capítulo 5 é dedicado á análise e projeto de módulos amplificadores e 
comparadores. Os projetos serão baseados nas análises contidas nos capítulos anteriores. 
Simulações elétricas serão realizadas para cada bloco, para a validação do projeto e 
obtenção das caracteristicas elétricas. 



2 Projeto analógico CMOS 

O objetivo do projetista analógico é transformar um conjunto de especificações 
em circuitos que satisfaçam estas especificações, tanto com seus esquemáticos, netlists e 
layouts. Isto resulta em uma tarefa muitas vezes complexa, pois o projeto de circuitos 
analógicos ainda apresenta uma forte correlação com a experiência do projetista. Esta 
correlação está vinculada tanto aos conhecimentos específicos de projeto como ao uso 
dos modelos de simulação existentes, assim como ao conhecimento de sua tecnologia. 

Deflnlç.40 do projeto 
(especincaçBes) 

1 
Síntese I Implernentaç?io 

1 
Layout 

1 
Fabricação 

1 
Circuiio 

Final 

FIGURA 2.1- Fluxo para oprojeto analógico CMOS 

A figura 2.1 ilustra uma aproximação geral dos passos necessários para o projeto 
analógico CMOS baseado em [ALL 20021. O projetista é responsável por todos estes 
passos exceto a fabricação. Porém o envolvimento do projetista somente é requerido na 
fase de teste dos protótipos da primeira fabricação. O teste de CIs em produção é tarefa 
diferenciada, que em muito é apoiada pelas técnicas de testabilidade ou DFT (design for 
testability). 

Primeiramente, uma extensa caracterização da tecnologia a ser usada deve ser 
feita, onde os parâmetros que descrevem as características particulares dos dispositivos 
são obtidos. A partir desta caracterização e das especificações requeridas para o circuito 
é feita uma modelagem e síntese a fim de se obter a dimensão dos transistores. A seguir, 
são usadas ferramentas para a análise do desempenho elétrico do circuito (simuladores 
elétricos, como Spice), onde o projetista deve realizar uma iteração usando os resultados 
de simulação a fim de melhorar o desempenho do circuito. Com a performance desejada 
satisfeita, é feita a sua descrição geométrica (layout). Com os dados do layout, uma 



nova simulação elétrica é feita incluindo os efeitos geométricos (os parasitas R, L e C 
extraídos do layout). Depois de todos estes passos, se os resultados forem satisfatórios, 
o circuito está pronto para fabricação. Senão, uma nova iteração de projeto deve ser 
realizada. 

O objetivo deste capítulo é discutir brevemente sobre o projeto de circuitos 
integrados analógicos CMOS. Serão detalhadas as caracteristicas importantes 
necessárias ao projetista analógico a fim de se obter um modelo analítico confiável que 
emule o comportamento do dispositivo: conhecimento da tecnologia CMOS, 
modelagem do transistor, e caracterização de parâmetros de tecnologia. 

2.1 Tecnologia CMOS 

Atualmente a tecnologia CMOS (Complementary Metal Oxide Semiconductor) é 
bastante difundida na indústria, sendo usada tanto em circuitos analógicos como 
circuitos digitais, devido em grande parte á possibilidade que se obter circuitos com 
grande densidade, permitindo a realização e construção de sistemas cada vez mais 
velozes e complexos. 

A tecnologia de semicondutores é baseada em vários passos de processos físico- 
químicos bem definidos e caracterizados. Portanto decidiu-se, nesta seção, focar-se na 
análise dos principais dispositivos usados no projeto analógico em tecnologia CMOS: o 
transistor MOS e os componentes passivos. 

2.1.1 Transistor MOS 

Aqui é descrito de maneira sucinta o comportamento do transistor MOS, 
baseado em [ALL 20021 [MüL 961 [RAB 961. Esta análise é feita para o transistor 
NMOS (canal tipo N, de enriquecimento, e substrato P), mas pode ser estendida ao 
transistor PMOS. 

A estrutura básica do transistor é mostrada na figura 2.2. Esta estrutura é 
composta por um substrato de material semicondutor tipo P (BULK) no qual foram 
difundidas duas regiões de material fortemente dopado (N+) chamadas fonte 
(SOURCE) e dreno (DRAIN). A região entre o dreno e a fonte é coberta por uma 
camada fina de óxido sobre a qual é colocado o eletrodo de porta (GATE) feito de metal 
ou de polisilício com alta dopagem e baixa resistividade. 

B 

FIGURA 2.2 - Estrutura do transistor NMOS 



Ao se aplicar uma tensão entre a porta e o substrato, induz-se um campo elétrico 
vertical que repele da superfície os portadores majoritários (lacunas) e atrai os 
portadores minoritários (elétrons). Isto causa a formação na superfície de uma camada 
fina de elétrons chamada de canal. No modo normal de operação do transistor MOS, 
uma vez que os portadores que formam o canal são móveis, os mesmos podem fluir da 
fonte ao dreno, produzindo uma corrente de condução quando presente uma tensão 
dreno-fonte (VDS). 

Em transistores NMOS, o potencial de dreno é maior que o potencial de fonte, e 
em transistores PMOS, o potencial de fonte é maior que o potencial de dreno. A tensão 
porta-fonte (VGS) determina a concentração de portadores no lado S (fonte) do canal; a 
tensão de porta correspondente quando a corrente no canal se toma significante é 
chamada de threshold voltage (ou tensão de limiar) Vt. Se VGS é maior que Vt, a 
corrente IDS percorre o transistor do dreno para a fonte (canal). 

As caracteristicas de corrente versus tensão para VGS > Vt podem ser divididas 
em duas regiões: a região linear e a região de saturação. Na região linear as 
caracteristicas de transferência de corrente são lineares em relação a VDS , enquanto na 
região de saturação IDS não depende de VDS. Também existe a região próxima a VGS = 

Vt onde a corrente depende exponencialmente de VGS, esta é a região de inversão fraca. 

2.1.2 Componentes passivos 

Nesta seção são examinados rapidamente os componentes passivos que são 
compatíveis com o processo de fabricação usados para se construir um circuito CMOS. 
O estudo aqui compreende os componentes passivos capacitores e resistores [ALL 
20021. No projeto de circuitos analógicos integrados, capacitores estão sempre 
presentes. 

Existem basicamente dois tipos de capacitores em tecnologia CMOS. Uma 
maneira de se obter um capacitor é usando uma camada de condutor (metal ou 
polisilício) sobre o silício cristalino separados por um dielétrico (óxido de campo). O 
segundo tipo de capacitor é formado por duas camadas condutoras (como metal ou 
polisilício) separadas por um dielétrico. Geralmente estas duas camadas são separadas 
por óxido fino. A figura 2.3 mostra o exemplo da implementação de um capacitor com 
duas camadas de polisilício separadas por um dielétrico. 

segundo nivel de polisilicio 

\ primeiro nível de polisiifcio 

óxido de campo 

FIGURA 2.3 - Capacitor ~olisilicio-Óxido-polisilicio [ALL 021 



Outro componente passivo usado em projeto analógico CMOS é o resistor. Os 
resistores compatíveis em tecnologia CMOS mais comuns incluem os tipos difusão e 
polisilicio. O resistor tipo difusão é implementado usando regiões de difusão 
fonteldreno, produzindo valores de resistência entre 10 a 100 ohms/quadrado. Já o 
resistor tipo polisilicio, mostrado na figura 2.4, é formado por uma camada de polisilicio 
que é rodeada por uma fina camada de óxido, produzindo um resistor com parasitas bem 
menores e independente da polarização. 

metal 
\ reslslor de polisllklo 

._.-, . . . . .. .. 

óxido de =arn 

FIGURA 2.4 - Resitor Polisilício [ALL 021 

A tabela 2.1 apresenta alguns valores típicos dos elementos passivos discutidos 
acima para a tecnologia AMS0.35pmun, como, por exemplo, as capacitâncias parasitas do 
polisilicio ao substrato. 

TABELA 2.1 - Valores típicos dos elementos passivos para a tecnologia AMS035pm 

Tipo de Componente Valores 
Capacitor poly-poly 0,78 - 0,96 i ~ / ~ m '  
Capacitor poly-well 0,099 - 0,119 i ~ / ~ m '  

Resistor poly 40 - 60 &/O 
Resistor difusão 60 - 100 &/O 

2.2 Modelagem do transistor MOS 

A principal função do projeto analógico é prever e verificar a performance do 
circuito ou sistema. Esta função é alcançada através do uso de modelos elétricos que 
emulam o funcionamento destes circuitos, em particular o comportamento das correntes 
e cargas como função das tensões terminais do dispositivo (I(V) e Q(V)). Segundo 
[ALL 021, modelagem é definido como o processo em que as propriedades elétricas de 
um dispositivo semicondutor (ou um grupo de dispositivos interconectados) são 
representadas por equações matemáticas, representação de circuitos ou tabelas. 

A seguir será descrito e analisado um modelo simples (ordem zero - inversão 
forte) baseado em [ALL 20021 e [LAK 941 que modela a operação do transistor MOS. 
A análise será feita para o transistor NMOS, mas pode ser estendida ao transistor 
PMOS. 



2.2.1 Modelo DC (modelo de grandes-sinais) 

A principal aplicação para o modelo DC é prever o comportamento em grandes- 
sinais do transistor. Neste comportamento inclui-se a polarização (biasing) dos 
transistores, ou seja, os valores DC das correntes do dispositivo. A figura 2.5 mostra o 
sentido das tensões e correntes de polarização do transistor MOS. 

(a) (i>) 

FIGURA 2.5 - Tensões e correntes de polarização para transistores (a) NMOS e (b) PMOS 

Pode se obter, então, um modelo simplificado para se calcular a corrente do 
transistor MOS baseado em [ALL 20021 e [LAK 941, usado em simuladores elétricos 
como Spice quando se especifica o nível mais simples de modelagem do transistor 
(nível I), resultando na equação 2.1. Os parâmetros são definidos na tabela 2.2. 

TABELA 2.2 - Defmição dos parâmetros do modelo analítico simplificado de transitares de canal longo 
para se calcular a corrente do transistor MOS 

Parâmetro Descrição 

PO Mobilidade do canal 
Cox = ~oltox Capacitância do óxido por 

unidade de área 
W Largura do canal 
L Comprimento do canal 
L Efeito de modulação do 

comprimento do canal 
Vt Tensão de limiar (threshold 

voltage) 
n Fator de inclinação 

(slopefactor) 

2$F Potencial da superfície em 



A partir da equação 2.1 podem-se identificar as regiões de operação do transistor 
MOS. Estas regiões de operação dependem do valor de VGS - Vt. Se VGS - Vt é zero OU 

negativa o transistor está na região de corte. A segunda região ocorre quando VDS é 
maior de VDS,,~ = (VGS - Vt), OU seja, a corrente ID se torna fracamente dependente de 
VDS, portanto o transistor está na região de saturação. Se VDS é menor que VDS,,~, o 
transistor está na região não-saturada (linear). 

Portanto, a partir da equação 2.1 e desprezando o efeito de modulação do canal, 
podem-se obter equações simplificadas para ID em cada região de operação do 
transistor, como mostra a tabela 2.3. A figura 2.6 ilustra as caracteristicas de tensão e 
corrente em cada região de operação do transistor MOS. 

TABELA 2.3 - Equações simplificadas para ID em cada região de operação do transitar MOS 

Região de Corte I ,  = o , v G s - v t < o  
Região não-saturada ~ . C O X  W 

(região linear) I, = 4 2 .  (V,, - V ~ ) - V , ~ ] . V , ~  
2.n L 

o < v,, < vos - vt 
Região de Saturação po u" COX W 

I ,  = . -. (vGs - v t y  
2.n L 
o < vos - vt < v,, 

Região de saturação 4 

Efeitos de Modiilação do Canal 

FIGURA 2.6 - Características genéricas de tensão e corrente em cada região de operação do transistor 
NMOS. 

As caracteristicas mostradas anteriormente estão relacionadas á operação do 
transistor em inversão forte, ou seja, onde os valores de ID e VGS são grandes e o 
potencial de superfície é maior que 2$F. Entretanto para valores de ID pequenos, VGS é 
um pouco maior que Vt (e em alguns casos até menor), ou seja, o transistor está na 
região de inversão fraca. A figura 2.7 ilustra esta característica, onde se tem o gráfico 
do log (ID) versus VGS. Abaixo da tensão de limiar, a corrente diminui 
exponencialmente até obter-se um valor pequeno (IoFF,) para VGS = 0, O que caracteriza 
a região de inversão fraca. 



FIGURA 2.7 - Caracteristicas genéricas de tensão e corrente do tramistor NMOS - modelo de inversão 
fraca 

2.2.2 Modelo AC (modelo de pequenos-sinais) 

Com os pontos de polarização definidos, um modelo de pequenos-sinais pode 
ser usado para se determinar as caracteristicas de pequenos-sinais. O modelo de 
pequenos-sinais é um modelo linear que ajuda a simplificar alguns cálculos, somente 
válido nas regiões de operação onde as tensões e correntes de grandes-sinais podem ser 
representadas por uma linha reta, ou seja, quando são lineares. Portanto, a fim de ser 
avaliar a resposta de ganho, por exemplo, de um estágio de um circuito analógico, são 
usados modelos de pequenos-sinais. A figura 2.8 mostra circuito equivalente de 
pequenos-sinais para o transistor MOS. Todos os parâmetros do modelo de pequenos- 
sinais estão relacionados com os parâmetros de grandes-sinais e tensões de polarização 
assumidas constantes naquele ponto de polarização. Os resistores r~ e rs representam a 
resistência ôhmica de dreno e fonte, respectivamente. 

s A 
FIGURA 2.8 - Circuito equivalente de pequenos-sinal., para o transistor MOS 



A seguir pretende-se descrever cada um destes parâmetros, considerando sempre 
o transistor na região de saturação. 

2.2.2.1 Transcondutâncias 

A relação entre corrente e tensão no modelo de pequenos-sinais é dada pela 
variação (derivada) de I em relação a V do transistor, a chamada transcondutância. No 
modelo de pequenos sinais podem ser identificados três tipos de transcondutâncias: g,, 
gmb e g,,. Estes parâmetros são definidos na tabela 2.4. 

A transcondutância g, é dada pela variação de ID em relação a VGS, que fornece 
a razão entre a corrente de saída e a tensão de entrada do transistor, ou seja, fornece a 
função de transferência do transistor. 

A transcondutância de substrato g,b representa a relação da tensão VBS e a 
corrente ID do transistor. 

A transcondutância de saída gd, (g,) fornece a resistência de saída do transistor, 
ou seja, g,=l/r,. Isto é resultado do efeito de diminuição do comprimento do canal por 
VDS. Isto faz com que a corrente aumente lentamente em função do aumento de VDS, 
como se pode notar na figura 2.6. Como se pode ver na tabela 2.4, a resistência de saída 
do transistor (i/gd,) depende inversamente do parâmetro L, que por sua vez depende 
diretamente do comprimento do canal L. 

TABELA 2.4- Definição dos parâmetros de trancondutância do modelo de pequenos-sinal., do transitar 
MOS 

Parâmetro Definição Cálculo do valor em relação á 
corrente DC elou Tensão DC 

g m  dl, ,Llo.cox W 

av,, 

2.2.2.2 Capacitâncias 

Com circuitos operando cada vez mais em altas freqüências, a estimativa das 
capacitâncias parasitas se tornam importantes para o projeto analógico, e devem ser 
adicionadas no modelo de pequenos sinais. Aqui a análise focará as capacitâncias 
internas do transistor MOS, desconsiderando as capacitâncias de interconexões dos 
dispositivos. 

As capacitâncias internas do transistor MOS são listadas na tabela 2.5. A 
capacitância de cada terminal do transistor CGS, CGD, CGB, CDB e CSB são determinadas 
através de parâmetros de capacitância internos do transistor. CGDO é a capacitância de 
overlap entre porta e dreno, CGBO é a capacitância de overlap entre porta e substrato, 



CJ é a capacitância de junção entre substrato e dreno e CJSW a é a capacitância de 
junção side wall entre fonte e dreno. 

TABELA 2.5 - Capacitâncias do modelo de pequenos-sina& do transistor MOS 

Capacitância Definição 

" 

CGD CGDO . W 
CGB CGBO .L 
Cna C J .  AD+CJSW .PD 

2.2.2.3 Modelo de pequenos-sinais simplificado 

A fim de simplificar os cálculos para a avaliação da resposta de um estágio de 
um circuito analógico, pode-se obter um modelo simplificado de pequenos-sinais 
considerando a transcondutância g,,, e a resistência de saída r,, mostrado na figura 2.9. 
Em pequenos sinais ou tensão AC, VGS controla a corrente ID por meio de uma fonte de 
corrente controlada com valor de grn.VGs. 

FIGURA 2.9 - Modelo de pequenos-sinais simplificado para o tramistor MOS 

2.3 Caracterização de parâmetros elétricos do transistor MOS 

Na seção anterior foi apresentado um modelo que emula o transistor MOS na 
região de inversão forte, sob várias condições de funcionamento de acordo com seus 
terminais (S, G, D, B). Entretanto, antes de qualquer modelo ser usado, é importante que 
os parâmetros que descrevem caracteristicas particulares de um dado dispositivo sejam 
conhecidos. Portanto, antes que o projeto comece, os dispositivos a serem usados devem 
ser caracterizados para que se obtenha um modelo com seus parâmetros devidamente 
determinados. Como geralmente os parâmetros de tecnologia não são totalmente 
fornecidos pelas foundries para todos os modelos, é necessário que o próprio projetista 
caracterize os dispositivos físicos a serem usados, através de medidas elétricas. 

Como ainda não se possui dispositivos físicos (transistores de teste) para a 
caracterização na tecnologia aqui em uso, AMS0.35pmun, a solução encontrada foi o uso 
de simulações elétricas com o modelo elétrico disponível, o modelo BSIM3v3.2.2 [LIU 
991. Primeiramente, vários parâmetros da tecnologia AMS0.35pm podem ser obtidos 
diretamente do modelo Spectre BSIM3v3.2.2. A tabela 2.6 mostra a relação destes 
parâmetros de tecnologia. 



TABELA 2.6 - Parâmetros de processo da tecnologia AMS035um - Modelo SPECTRE BSIM3v3.2.2 

Parâmetro Descrição Valor Unidade 
NMOS PMOS 

NC h Concentração de dopagem 2,31e+17 1,03e+17 l/cm3 

W Mobilidade do canal 403,5 129,6 cm2/vs 
Tox Espessura de óxido de porta 7,700e-07 7,700e-07 cm 
Cox Capacitância do óxido 4,48e-7 4,48e-7 ~ / c m '  
Vto Tensão de limiar @ Vbs = O 0,465 -0,617 V 

CGDO Capacitância de overlap entre 2,le-10 1,9e-10 F/m 
porta e dreno por unidade de 

comprimento de canal 
CGBO Capacitância de overlap entre 2,le-10 1,9e-10 F/m 

porta e substrato por unidade de 
comprimento de canal 

Observando-se a equação 2.1 (do modelo de ordem zero apresentado), dois 
parâmetros importantes para o cálculo da corrente ID do transistor, o fator de inclinação 
n (slope factor) e VA (tensão de Early, que é inversamente proporcional ao parâmetro 
h) devem ser conhecidos. Porém estes parâmetros não são fornecidos, pois o modelo 
elétrico BSIM3v3 possui equações para estes parâmetros que dependem de outros 
parâmetros caracteristicos do modelo. 

A seguir serão descritos os processos de obtenção destes parâmetros através de 
métodos gráficos e numéricos desenvolvidos em [CUN 961 [GOM 951 P A I  20011. 

2.3.1 Determinação do parâmetro Fator de Inclinação - n 

A fim de se calcular corretamente a corrente de polarização (ID) do transistor, é 
necessário levar em consideração o parâmetro chamado de fator de inclinação n (slope 
factor). Este parâmetro é interpretado como a inclinação da curva log(1~) versus VGS na 
região de inversão fraca, como é ilustrado na figura 2.10. Portanto, fica clara a 
importância deste parâmetro para o projeto analógico. 

VGS 

FIGURA 2.10 - Defmição gráfica do parâmetro fator de inclinação (n) 

São abordados três métodos para a obtenção do valor de n para a tecnologia 
AMS0.35pm. O primeiro é uma aproximação inicial usando uma equação matemática, 



o segundo a partir da curva gm/ID característica desta tecnologia, e o terceiro através da 
variação da tensão de pinch-off (VP) baseado no modelo elétrico EKV [ENZ 971. A 
seguir serão descritos os três métodos. 

2.3.1.1 Método 1 - Analítico 

O primeiro método pode fornecer uma aproximação inicial de n, usando a 
seguinte relação baseada em [MüL 861 

A capacitância do óxido por unidade de área (Cox) pode ser obtida diretamente 
da tabela 2.6, e a capacitância de depleção (Cd) é obtida a partir das equações 2.3, 2.4, e 
2.5 (todos os parâmetros usados nestas equações estão listados na tabela 2.6, onde Nb - 
dopagem do substrato - é aproximada pelo valor de Nch). A tabela 2.7 mostra os 
valores obtidos de n utilizando este método. 

' s i  Cd =- xd (Eq. 0.3) 

2 . K . T  
2Df = 

4 ' ln[?] (Eq. 0.5) 

TABELA 2.7 - Valores extraídos de n para a tecnologia AMS035um - Método Analítico 

NMOS PMOS 
n 1,335 1,134 

2.3.1.2 Método 2 - Característica gm/ID do transistor 

Este método leva em consideração a caracteristica ~,/ID versus ID/(W/L) do 
transistor. Foi seguido o seguinte procedimento (que será melhor detalhado no próximo 
capítulo): 

a curva ID versus VG, com VD = 3,3V e Vg = VS = OV é obtida via simulação 
elétrica Spectre de um transistor NMOS de W/L=1 (W=lOpm L=lOpm), de 
acordo com a configuração mostrada na figura 2.11; 
é calculado ln(1~) de cada ponto; 
é calculada a derivada de ln(1~) em relação a VG para cada ponto; 
é plotado g m / I ~  X ID/(W/L); 
o mesmo procedimento é repetido para o transistor PMOS de WL=l ,  com as 
tensões de polarização invertidas. 



FIGURA 2.11 - Configuração do transitar NMOS para a obtenção da cuma I, versus VG 

O Valor de gm/iD é máximo na região de inversão fraca, onde é igual a l/(nUt), 
portanto pode-se obter o valor de n. A tabela 2.8 mostra os valores máximos obtidos de 
gm/ID, e conseqüentemente de n. 

TABELA 2.8 - Valores extraídos de n para a tecnologia AMS035um - Método curva &/ID - - 
'MOS - - 

&&E 30,06 - 
n 1,29 1,28 

M O S  I 
29,75 

2.3.1.3 Método 3 Variação da tensão de pinch-off (Vp) 

Este método é baseado em [CUN 961, levando em consideração uma outra 
interpretação ao fator de inclinação n. Pode-se considerar o parâmetro equivalente ao 
inverso da derivada de Vp em relação a VGB. A tensão de pinch-off (Vp) é definida como 
a tensão de canal no limite entre a região de inversão fraca e a região de inversão forte 
[ENZ 971. Portanto, pode-se obter a seguinte relação 

1 
V p  - ' (VG - V ~ O )  (Eq. 0.6) 

n 
Vp é obtido a partir das características "porta-comum", curvas obtidas através do 

procedimento descrito a seguir. A partir deste método os valores do parâmetro tensão de 
limiar para Vbs = O (Vto) também podem ser obtidos. 

Foi realizado o seguinte procedimento: 
a curva ID x Vs com VG = VD = (0,7 - 0,s - 0,9 - 1 - 1,5 - 2 - 2,5 - 2,s - 3) V e 
VB = OV é obtida via simulação elétrica Spectre de um transistor NMOS de 
WL=1 (W=lOpm L=lOpm), de acordo com a configuração mostrada na figura 
2.12; 

calcula-se o ponto da corrente de normalização (1s  = 2 .  n . b. u t Z ,  usando uma 

primeira aproximação para n) da curva 
Para cada valor de 1s e VGS, acha-se a tensão Vp correspondente; 
é plotado Vp x VGB; 
valor de n é obtido através da derivada da Vp x VGB; 
valor de Vto é obtido através do ponto da curva em que VP = 0; 



o mesmo procedimento é repetido, variando-se o valor de 1s , a fim de se 
observar a variação dos valores de n e Vto obtidos em funçjo da variação de 1s; 
todo o procedimento é repetido para o transistor PMOS de W/L=l, com as 
tensões de polarização invertidas. 

FIGURA 2.12 - Configuração do transitar NMOS para a obtenção da cuma I, versus Vs 

A tabelas 2.9 e 2.10 mostra os valores obtidos de n e Vto, para cada ponto de 1s 
escolhido. A figura 2.13 mostra a curva ID versus Vs para o transistor NMOS, com o 
ponto 1s escolhido para se achar se a tensão Vp correspondente. Já a figura 2.14 mostra a 
característica Vp versus VGB do transistor, onde se obtêm os valores de n (derivada da 
curva) e Vto (ponto em que Vp é nulo). 

FIGURA 2.13 - Caractefistica I, versus V, do transistor NMOS com o ponto 1s escolhido para se achar se 
o seu V, correspondente 



VGB (V) 

FIGURA 2.14 - Caractenstica V, versus V, do transistor NMOS para cada 1s diferente 

TABELA 2.9 - Valores extraídos de n e Vto para a tecnologia AMS035um, transitar NMOS - Método 
variação da tensão de pinch-o$(V,) 

1s (A) n Vto (V) 
100n 1,221 0,502 
296n 1,224 0,545 

TABELA 2.10 - Valores extraídos de n e Vto para a tecnologia AMS035um, transistor PMOS - Método 
variação da tensão de pinch-o$(V,) 

1s (A) n Vto (V) 
-lOn 1,1704 -0,565 

-91.19n 1,1733 -0,667 
-200n 1,1737 -0,705 

2.3.1.4 Comparação entre os métodos 

Os valores de n estimados pelos três métodos diferem bastante. O primeiro 
método (analítico) não é confiável pelo fato de que a dopagem Nb (ou Nch) é bastante 
uniforme nas tecnologias CMOS atuais. O parâmetro Nb neste caso é um parâmetro de 
ajuste de corrente em regimes de condução não informados ao projetista. 

O segundo método, baseado na curva gm/ID versus iD/(W/L), também não 
fornece uma estimação correta, pois considera o valor máximo de gm/ID na região de 
inversão fraca, onde o transistor geralmente não está em operação durante o 
funcionamento de circuitos analógicos. 

O terceiro método é o mais aplicável ao projeto, por resultar em um valor de n 
razoavelmente constante nas regiões de inversão fraca e moderada. 



2.3.2 Determinação do parâmetro Tensão de Early - VA 

O parâmetro Tensão de Early (VA) é a tensão por unidade de comprimento do 
canal fazendo uma analogia á tensão de Early do transistor bipolar [LAK 941 (em alguns 
modelos, como o Spice nível 1, o parâmetro L emula este efeito, onde VA=l/L). Este 
parâmetro é essencial para o projeto analógico CMOS, pois a resistência de saída do 
transistor depende diretamente deste parâmetro, que por sua vez está extremamente 
ligado ao comprimento do canal (L) do transistor. De acordo com a definição de gd, 
(seção 3.2.2. I), pode-se obter a seguinte relação 

VA 
r. =- 

(Eq. 0.7) 
I ,  

Geralmente, os estágios de ganho de um amplificador CMOS dependem 
diretamente da resistência de saída dos transistores que o compõem, portanto, é 
necessário se obter valores confiáveis deste parâmetro. 

Considerando que o parâmetro VA depende do efeito de diminuição do 
comprimento do canal por VDS, ou seja, o efeito em que a corrente aumenta lentamente 
em função do aumento de VDS, pode-se obter o valor de VA a partir da curva ID versus 
VDS do transistor MOS, como mostra a figura 2.15. 

V A 4  V A 3  V A 2  V A I  VDS 

FIGURA 2.15 - Relação da VA em função da cuma ID versus VDS do transitar NMOS 

Portando, para a obtenção dos valores de VA para a tecnologia AMS0.35pm foi 
seguido o seguinte procedimento: 

a curva ID x VD, com VG = (0,7 - 1 - 1,5 - 2 - 3) V e VB = VS = OV é obtida via 
simulação elétrica Spectre de um transistor NMOS de W=lOpm para L 
diferentes (1 - 1,5 - 2 - 2,5 - 5 - 7,5 - 10) p m  de acordo com a configuração 
mostrada na figura 2.16; 
o valor de VA é extraído para cada valor de L e VGB através do método ilustrado 
na figura 2.13; 
o mesmo procedimento é repetido para o transistor PMOS com as tensões de 
polarização invertidas. 



FIGURA 2.16 - Configuração do transistor NMOS para a obtenção da curva I, versus VD,para a extração 
do parâmetro VA 

As tabelas 2.11 e 2.12 mostram os valores obtidos, através do método descrito, 
de tensão de Early para a tecnologia AMS0.35pm para os transistores NMOS e PMOS, 
respectivamente. Observando-se os resultados fica clara a dependência de VA em 
relação ao comprimento do canal do transistor, assim como a sua tensão VGB. AS figuras 
2.17 e 2.18 ilustram melhor a relação linear da variação da tensão de Early em função 
da variação L e VGB. 

TABELA 2.1 1 - Valores extraidos de VA para a tecnologia AMS035um - Transitar NMOS 

L (um) 
FIGURA 2.17 - VA em função da v c a ç ã o  L e VGB do transistor NMOS - Tecnologia AMS035pm 



TABELA 2.12 - Valores extraídos de VA para a tecnologia AMS035um - Transistor PMOS 

VA (V) 
VGB(V) -0.7 -1 -1.5 -2 -3 

L (w) 
1 25,66 31,33 30,21 28,31 27,55 

1.5 52,51 49,41 44,17 40,48 38,24 
2 70,84 64,3 57,16 51,98 48,06 

1 2 3 4 5 6 7 8 9 1 0  

L (um) 
FIGURA 2.18 - VA em função da v c a ç ã o  L e V, do transistor PMOS - Tecnologia AMS035pm 

A partir destas curvas, pode-se obter as seguintes relações para a tensão de 
Early para esta tecnologia 

VA L ( E ~ .  0.8) 

VA = f (V,,) (Eq. 0.9) 

Também foram caracterizados (da mesma maneira descrita anteriormente) 
transistores de canal curto (L = 0,3 - 0,5 - 0,s pm) desta tecnologia. As figuras 2.19 e 
2.20 ilustram a relação da variação da tensão de Early em função da variação L e VGB 
para transistores de canal curto. Obsenra-se que a variação de VA não é mais linear, 
efeito bem mais presente no transistor PMOS, caracterizando os efeitos de canal curto 
do transistor nesta tecnologia (lembrando que as simulações são feitas com o modelo 
BSIM3v3.2.2). 



FIGURA 2.19 - VA em função da variação L e V, para transitares NMOS de canal curto - Tecnologia 
AMS035um 

FIGURA 2.20 - VA em função da variação L e V, para transitares PMOS de canal curto - Tecnologia 
AMS035um 

Muitas vezes o projetista escolhe a região de operação do transistor a ser usado e 
a partir dai escolhe seu tamanho, e, conseqüentemente, seu VA. Portanto, é interessante 
ao projetista o conhecimento da variação de VA em relação a região de operação do 
transistor. As figuras 2.21 e 2.22 ilustram a relação da variação da tensão de Early em 
função da variação da caracteristica gm/I~  do transistor para diversos comprimentos de 
canal diferentes. Portanto, pode-se obter uma curva de VA versus a caracteristica 
universal de gm/ID (que será mais detalhada no capitulo 4) para ser explorada durante o 
projeto, onde as dimensões dos transistores são desconhecidas. 



FIGURA 2.21 - VA em função da camctenstica g,A, para L diferentes do transistor NMOS - Tecnologia 
AMS035um 
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FIGURA 2.22 - VA em função da caractenstica ~ , A D  para L diferentes do transistor PMOS - Tecnologia 

AMS035pm 

Os dados obtidos nesta seção resultam numa poderosa ferramenta para o 
projetista, pois dá mais liberdade na escolha do comprimento do canal (L) do transistor 
de acordo com a região de operação do transistor, a fim de se obter, por exemplo, 
estágios de ganho para amplificadores. Com o (WIL) do transistor conhecido, o 
projetista pode escolher o L de acordo com o VA requerido. 



2.4 Conclusão 

A análise feita neste capítulo é muito importante no projeto de circuitos 
analógicos. A partir do conhecimento da tecnologia a ser usada, uma modelagem 
confiável do dispositivo e caracterização dos parâmetros de tecnologia deste dispositivo, 
o projetista é capaz de prever o comportamento do circuito a ser implementado. 

Primeiramente, foi feita a analise do principal dispositivo usado no projeto 
analógico em tecnologia CMOS: o transistor MOS. Foi analisado um modelo 
simplificado para se calcular a corrente do transistor MOS usado em modelos SPICE 
nível 1, e a partir disto foi desenvolvido a modelagem AC e DC do transistor MOS, que 
emulam o funcionamento deste dispositivo. 

A partir desta modelagem os parâmetros de tecnologia que descrevem as 
características particulares do transistor MOS. A maioria dos parâmetros foi obtida a 
partir do modelo elétrico disponível, o modelo BSIM3v3.2.2. Também foram descritos 
os processos de obtenção de dois parâmetros muitos importantes para o projeto 
analógico, n (fator de inclinação) e VA (tensão de Early). 

Foram usados três métodos para a obtenção do valor de n para a tecnologia 
AMS0.35pm porém o terceiro método foi considerado o mais eficaz, pois é baseado em 
um modelo desenvolvido para circuitos analógicos (EKV) onde o parâmetro equivale ao 
inverso da derivada de Vp em relação a VGB ( ~ W S  = 1,22 e np~os  = 1,17). 

O parâmetro VA, que determina diretamente a resistência de saída do transistor, 
está extremamente ligado ao comprimento do canal (L) do transistor,. Portanto, este 
parâmetro foi caracterizado, a partir do efeito de diminuição do comprimento do canal 
por VDS (curva ID versus VDS) do transistor. A relação da variação da tensão de Early 
em função da variação L e VGB para o transistor foi obtida a partir das simulações da 
corrente DC fornecidas pelo modelo elétrico BSIM3v3, dando mais liberdade ao 
projetista na escolha do L do transistor a fim de se obter estágio de um circuito com a 
resistência de saída desejada. Porém também é interessante ao projetista o 
conhecimento da variação de VA em relação á região de operação do transistor, 
portanto a característica de VA em função da variação da característica g,/ID do 
transistor para diversos comprimentos de canal foi obtida. 

Os dados obtidos neste capítulo devem ser validados por medidas em 
dispositivos de teste, pois a caracterização de n e VA foi baseada no modelo elétrico 
BSIM3v3 simulado com os parâmetros nominais da foundry. 



3 Análise e projeto de subcircuitos analógicos básicos 

No capitulo anterior foram analisadas as caracteristicas de tecnologia, 
modelamento, e caracterização dos dispositivos CMOS. Portanto, o próximo passo é a 
análise e desenvolvimento de subcircuitos. Subcircuitos são considerados combinações 
de circuitos simples (com um ou mais transistores), a fim de se gerar circuitos com 
funções mais complexas. Conseqüentemente, os circuitos tratados neste capitulo podem 
ser considerados como "blocos construtivos" (building blocks). 

Neste capitulo serão tratados os seguintes subcircuitos considerados básicos para 
se construir os blocos analógicos a serem implementados neste trabalho: chave MOS, 
resistores ativos, espelho de corrente, inversor CMOS e par diferencial. 

3.1 Transistor de passagem operando como chave - Chave MOS 

A chave MOS é bastante usada em projeto de circuitos analógicos, pois é usada 
para implementar diversas funções, tais como simulações de resistores chaveados, 
multiplexação, modulação, e diversas outras aplicações. 

Uma chave MOS controlada por tensão é na verdade uma rede com três 
terminais, onde os terminais A e B são os terminais da chave, e o terminal C é o 
terminal de controle, como é ilustrado na figura 3.1. A tensão VC controla a chave e 
determina quando ela está no estado ON ou OFF. 

Bulk 

A 
(S :D) 

FIGURA 3.1 - Chave CMOS controlada por temão 

As principais caracteristicas de uma chave MOS são as resistências RON e ROFF. 
Idealmente RON é zero e ROFF é infinita. Quando a chave está no estado OFF, VGS é 
menor ou igual a Vt, portanto o transistor está sempre na região de corte. Como a 
resistência OFF tem um valor alto (mas não infinito), existe uma corrente passando pelo 
transistor. Esta corrente de fuga tem valores na faixa de pA e aumentam de acordo com 
o aumento da temperatura [ALL 20021. 

No estado que a chave está ON, a tensão que controla a chave é pequena e VGS 
deve ser grande. Portanto, o transistor é considerado na região de não-saturação (ver 
capitulo 2). Considerando que VDS é pequeno, podem-se desconsiderar os efeitos de 
segunda ordem de VDS, obtendo-se 

p . C o x  W 
I ,  = ' - ' (vm - vt)' (Eq. O. 10) 

n L 



onde VDS é menor que V G S  Vt e maior que zero. Portanto pode-se obter uma expressão 
para RON 

1 
- - 

1 
R,  = d I D / d V D s  p . C o x  W (Eq. 0.1 1) 

. . ( v , ,  -vt) 
n L 

3.2 Resistores ativos MOS 

Para o projeto de um sistema analógico muitas vezes se necessita de um resistor 
para se produzir uma queda de tensão DC, ou de uma resistência em pequenos-sinais 
que seja linear para uma faixa de valores pequenos. Um resistor ativo, emulado por um 
transistor MOS, pode ser usado no lugar de um resistor de polisilisio ou difusão, 
obtendo-se um resistor equivalente com área muito menor. 

O resistor ativo é obtido por uma simples conexão entre os terminais de porta e 
de dreno do transistor como ilustra a figura 3.2. Para o transistor NMOS, o terminal 
fonte deve estar com o seu potencial mais próximo de VSS (terminal mais negativo), 
para que os efeitos de corpo do transistor sejam eliminados. Para o transistor PMOS, o 
terminal fonte deve estar com o seu potencial o mais próximo de VDD (terminal mais 
positivo). Como nesta conexão VGS = VDS, OU seja, o transistor está sempre na região de 
saturação, a transcondutância do transistor caracteriza o resistor ativo equivalente. A 
conexão entre os terminais porta e dreno significa que VDS controla ID e, portanto, o 
canal de transcondutância se torna o canal de condutância. Portanto, pode-se obter a 
resistência em pequenos sinais do dispositivo por 

A A - - 
r,,, - -- - (Eq. 0.12) 

g m  + g m b s  + g d s  g m  

FIGURA 3.2 - Resistor ativo CMOS. (a) NMOS. (b) PMOS 

A figura 3.3 ilustra a caracteristicas V-I de ambos os dispositivos da figura 3.2. 
Pode-se observar que o transistor está operando na região de saturação, ou seja, como 
um diodo onde a sua resistência é obtida a partir da região linear para uma determinada 
faixa de valores. 



FIGURA 3.3 - Caractenstica V-I do transistor no modo diodo 

Outra alternativa de se obter um resistor ativo é quando se conecta o terminal 
porta do transistor a uma tensão de polarização (VC). A figura 3.4 mostra este tipo de 
configuração, onde os terminais dreno e fonte formam os dois terminais do resistor. 
Entretanto, a região de operação não é garantida para todas as tensões de terminais para 
este tipo de resistor. Na verdade este tipo de resistor funcionará como a chave MOS 
descrita na seção anterior, obtendo-se uma faixa de valores grande mas não-linear. A 
tabela 3.1 mostra os valores de resistência obtidos a partir da região de operação do 
transistor. 

FIGURA 3.4 - Resistor ativo usando um transistor CMOS controlado pela tensão de polarização (VC). 

TABELA 3.1 - Cálculo da resitência obtida de um transitor a p a r b  da região de operação do transistor. 

Região não-saturada 1 - I 
(região linear) - - 

Yds p .COX w ..(v,, -vt) 
n L 

Região de Saturação VA 

3.3 Espelho de corrente 

O espelho de corrente é um bloco construtivo básico muito útil para o projeto 
analógico CMOS. Um espelho de corrente simples é ilustrado na figura 3.5. Consiste 
em dois transistores com VGS e características de processo (p . Cox) idênticos. Um é 
conectado como um diodo e polarizado com a corrente I D ~ ,  o outro fornece a corrente de 



saída I D ~  com uma alta impedância. Como possuem VGS iguais, a razão entre suas 
correntes é dada por 

r,,=,= ( W J L ) ,  
I,, (W J L) ,  ( E 9  0.13) 

FIGURA 3.5 - Espelho de corrente NMOS 

Escolhendo-se a razão B, a corrente I D ~  pode ser ajustada para um determinado 
valor com uma alta precisão. Geralmente, o comprimento de canal L é mantido igual 
para ambos os transistores a fim de se obter um bom casamento (ver próximas seções). 
Portanto, a razão B é definida pela largura do canal W. 

O espelho de corrente mostrado na figura 3.5 é a configuração mais simples e é 
usado com muita mais freqüência que qualquer outra. Há casos em que o projetista 
necessita espelhar uma corrente para diversas partes do circuito. Isto pode ser realizado 
colocando-se diversos transistores em paralelo como ilustra a figura 3.6. 

ID1 
JD2 41D3 4 I ~ 4  

FIGURA 3.6 - Espelho de corrente NMOS com diversas correntes espelhadas 

Para circuitos que necessitam de configurações com impedância de saída elevada 
e com menos erro entre as correntes de polarização, outras configurações devem ser 
usadas. Tais configurações, como espelho de corrente em cascata (cascode) e espelho de 
corrente Wilson, são detalhadas em [ALL 20021 [LAK 941. 



3.4 Par diferencial 

Um dos mais importantes blocos construtivos básicos para o projeto analógico é, 
sem dúvida, o par diferencial. Geralmente, este bloco consiste no estágio de entrada de 
um amplificador operacional. O par diferencial é formado basicamente de dois 
transistores iguais (ou casados). Um exemplo de um par diferencial NMOS é mostrado 
na figura 3.7, que consiste em dois transistores iguais e a fonte de corrente IB, que 
polariza ambos os transistores M1 e M2 com a mesma corrente iB/2. 

IBR IB 12 
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FIGURA 3.7 - Par diferencial NMOS 

O objetivo deste bloco é amplificar a tensão diferencial entre os terminais de 
gate de ambos os transistores. Na seção 3.6 será feita uma análise mais detalhada de um 
estágio diferencial que na verdade é implementado por um par diferencial e um espelho 
de corrente. 

3.5 Inversor CMOS 

Geralmente para se aumentar o ganho de um estágio de um amplificador a 
resistência de saída do mesmo deve ser aumentada. Isto pode ser feito colocando-se um 
transistor configurado como um resistor neste estágio, produzindo uma carga ativa. A 
configuração mais simples é mostrada na figura 3.8a, onde se tem um amplificador 
NMOS com uma carga ativa PMOS. Como resultado, a tensão de saída será invertida 
em relação á entrada. Portanto, este estágio é chamado de estágio inversor. 

Muitas vezes, necessita-se de estágios inversores com ganhos bem maiores do 
que os obtidos através da configuração carga ativa. Uma segunda configuração 
inversora, com um ganho bem maior, pode ser implementada. Em vez de uma carga 
ativa, uma fonte de corrente é usada. Uma das desvantagens desta configuração é que a 
fonte de corrente necessita de uma tensão de polarização. Isto pode ser resolvido com a 
configuração mostrada na figura 3.8b. Esta configuração, chamada de Push-Pull, 
fornece um alto ganho e uma boa excursão do sinal de saída [ALL 20021. 



FIGURA 3.8 - Inversor CMOS: (a) Configuração carga ativa; (b) Configuração Push-Pull 

O inversor é considerado o estágio básico de ganho para circuitos amplificadores 
analógicos CMOS. Porém estágios de alto ganho como estes requerem o uso de 
realimentação negativa para a estabilização do ponto de polarização. 

3.6 Estágio diferencial 

A figura 3.9 mostra um estágio diferencial CMOS usando par diferencial 
NMOS. O principal objetivo deste bloco é amplificar a tensão diferencial entre os 
terminais entrada em função de seu modo-comum. Portanto, pode ser considerado como 
um amplificador diferencial de um estágio, que é caracterizado pela sua tensão de 
modo-comum (VCMR) que especifica em que faixa de valores de modo-comum o 
amplificador continua "perceber" e amplificar com o mesmo ganho. 

FIGURA 3.9 - Estágio diferencial CMOS usando par diferencial NMOS 



Portanto, a fim de se obter uma análise confiável de qualquer estágio 
amplificador, deve-se analisar as seguintes caracteristicas: 

Comportamento DC (análise de grandes sinais); 
Limite máximo da variação do sinal de entrada; 
Comportamento AC (caracteristicas de pequenos sinais como ganho, Rout, etc.). 

A seguir, segue uma análise detalhada de um estágio diferencial usando par 
diferencial NMOS, a partir da modelagem do transistor MOS discutida no capitulo 2. 

3.6.1 Projeto de um estágio diferencial em tecnologia AMS0.35pm 

A fim de ilustrar o processo de análise de um circuito analógico, assim como as 
caracteristicas deste bloco em questão, a seguir serão descritas a análise e projeto de um 
estágio diferencial usando par diferencial NMOS. A partir de toda a modelagem do 
transistor MOS descrita no capitulo anterior e da análise dos subcircuitos descritos neste 
capitulo, uma metodologia de projeto baseada em [ALL 20021. O circuito será 
implementado na tecnologia AMS0.35pm. 

A figura 3.10 mostra a configuração estágio diferencial usando par diferencial 
NMOS (transistores M1 e M2), uma fonte de corrente controlada por tensão (transistor 
M5) e um espelho de corrente PMOS (M3 e M4) como carga. 

L 
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FIGURA 3.10 - Estágio diferencial CMOS usando par diferencial NMOS a ser implementado 

A análise do comportamento DC deste bloco deve ser feita considerando que o 
par diferencial M I M 2  opera sempre na região de saturação e que as correntes do 
espelho de corrente são idênticas. A tabela 3.2 mostra as equações que modelam o 
comportamento DC do estágio diferencial, onde as caracteristicas DC importantes para 
o projeto analógico são detalhadas. 



TABELA 3.2 - Equações que modelam o compodamento DC do estágio diferencial 

Característica DC Definição Equação 

IDS Corrente de polarização ~ ~ c o x  w 
da fonte de corrente M5 ID = .-.(V,, - ~ t ) ~  2 . n  L 

VGS = Vbias - VSS 
Pdiss Potência DC dissipada I,, . (VDD - VSS) 

Slew rate (SR) Taxa máxima de 
variação da saída no CL 

tempo 
Vin máximo (CMR+) Máxima tensão de 

modo-comum VDD - V,,, - VSGl 

Vin mínimo (CMR-) Mínima tensão de 
modo-comum "' + 'GS3 + 'SD1 - 'SG1 

O próximo passo é a análise AC deste circuito através de seu modelo de 
pequenos sinais. O modelo de pequenos sinais simplificado é mostrado na figura 3.10, 
onde é assumido que ambos os lados do circuito estão casados. Se esta condição for 
satisfeita, os terminais fonte de M1 e M2 podem ser considerados aterrados. A tabela 
3.3 mostra as equações que modelam o comportamento AC do estágio diferencial, onde 
as características em frequência de amplificadores analógicos são detalhadas. 

FIGURA 3.1 1 - Modelo de pequenos sinais simplificado do estágio diferencial CMOS usando par 
diferencial NMOS 

TABELA 3.3 - Equações que modelam o compodamento AC do estágio diferencial 

Caracteristica DC Definição Equação 
Av Ganho diferencial em baixa freqüência gml . Rout 

(Ganho DC) 

Rout Resistência de saída VAn VAp 
r0211 r04 = -11- 

I n 5 / 2  I n 5 / 2  . . . . 

F-3d~ Freqüência de corte 1 
2.ír.Rout.CL 

GB W Produto Ganho-Faixa g m1 



Com o comportamento do circuito devidamente caracterizado, parte-se para o 
seu projeto a partir das especificações. Deseja-se obter um estagio diferencial com as 
seguintes especificações: Av = 100 (40dB), F.3d~ > 100KHz, Pdiss 5 ImW, VCMR = -0,5V 
a lV, SR > 10V/ps, CL = 5pF, VDD = 1,65 V e VSS=-1,65 V. 

O procedimento de projeto é baseado metodologia desenvolvida em [ALL 
20021, e é ilustrado aqui buscando melhor performance nas especificações acima. Todas 
as caracteristicas DC e AC do transistor são calculadas a partir das equações das tabelas 
3.2 e 3.3, e do modelo discutido no capítulo anterior. O projeto segue a seguinte 
seqüência: 

a partir da especificação de SR, pode-se obter o limite minimo para a corrente de 
polarização: I ,  > SR.C, 3 I,, > 5 0 4  ; 

a partir da especificação de potência, pode-se obter o limite máximo para a 

corrente de polarização: = 
Pdiss 

SI , ,  c 3 0 3 d  ; 
(DD - VSS) 

a partir da especificação de F.3d~, pode-se obter o limite máximo para Rout: 

escolhe-se a corrente de polarização: 

1 D, I, ,  = 200pA 3 I,, = I, ,  = I , ,  = I , ,  = - = 1oopA ; 
2 

os tamanhos dos transistores do par diferencial NMOS (M1 e M2) são 
calculados a partir da especificação ganho: 

Av 
Av = 100 s g,, = - s g,, = 353,9@ uS = 7 ;  

Rout 
n 

"D5 

os tamanhos dos transistores do espelho de corrente PMOS (M3 e M4) são 
calculados a partir da especificação de VCMR,,: 

o tamanho do transistor M5 é calculado a partir da especificação de VCMR,,: 

A tabela 3.4 mostra a relação dos tamanhos dos transistores para este projeto. O 
comprimento de canal (L) é determinado a fim de se obter uma melhor relação entre 
área e ganho DC (devido a dependência da tensão de Early em relação ao L, como é 
mostrado na seção 3.2), aqui estimado em 5 vezes o L mínimo que a tecnologia permite. 

TABELA 3.4 - Dimensões dos transitares - Estágio diferencwl 

W L  w ( ~ 4  L ( ~ 4  
M1 7 10,5 1,5 
M2 7 10,5 1,5 



A tabela 3.5 mostra os resultados de performance do estágio diferencial, 
calculados analiticamente e através de simulações elétricas Spectre usando o modelo 
BSIM3v3.2.2. Nota-se que esta metodologia convencional, ainda bastante usada em 
projeto analógico, é suficiente para obter-se uma primeira aproximação para o projeto 
de um circuito, utilizando-se métodos simples. 

TABELA 3.5 - Resultados de performance do Estágio diferencial calculados e simulados 

Analítico Simulação Spectre 
(Modelo nível 1) (Modelo BSIM3v3) 

IDD (PA) 200 222,5 
Pdiss (mW) 0,66 0,73 

3.7 Técnicas de layout analógico 

Em relação ao layout de circuitos analógicos CMOS, diversas considerações 
devem ser feitas [GIR 20031 [HAS 20011. Esta seção traz uma descrição sucinta das 
principais técnicas de layout que serão usadas na implementação dos blocos analógicos 
analisados anteriormente. 

Como já mencionado, os blocos construtivos básicos mais importantes para 
o projeto analógico, o par diferencial e espelho de corrente, utilizam transistores MOS 
casados. O par diferencial necessita do pareamento da tensão porta-fonte, enquanto o 
espelho de corrente necessita do casamento das correntes de dreno. Porém, o tamanho, o 
formato e a orientação dos transistores MOS afetam o seu casamento. Transistores 
grandes casam com maior precisão que os pequenos, pois o aumento da área de porta 
ajuda a minimizar o impacto de flutuações localizadas. Transistores de canal longo 
casam melhor que os de canal curto, pois os canais longos reduzem as variações da 
largura das linhas e a modulação do comprimento do canal. Transistores orientados na 
mesma direção casam melhor que aqueles orientados em direções diferentes por causa 
da natureza anisotrópica do silício monocristalino. Outros tipos de descasamento são 
causados pela presença ou ausência de outras estruturas perto dos transistores casados. 

As técnicas de layout para casamento de transistores aqui tratadas serão 
exemplificadas para o subcircuito par diferencial, mostrado na figura 3.12. O mesmo 
pode ser aplicado ao espelho de corrente. 

FIGURA 3.12 - Par diferencial NMOS e seus termina& 



Uma técnica bastante utilizada para se obter estas configurações casadas é a 
técnica chamada de centróide comum. Descasamentos induzidos por diferenças de 
processo ou gradientes (variações produzidas por efeitos mecânicos ou térmicos) podem 
ser minimizados pela redução da distância entre os centróides dos dispositivos casados. 
Alguns tipos de layout podem realmente reduzir a distância dos centróides a zero. Estes 
layouts em "centróide comum" podem reduzir completamente os efeitos das variações 
mencionadas anteriormente. A figura 3.13 mostra a forma mais simples do layout de um 
par diferencial na configuração centróide comum, que produz um layout compacto e 
possui os dois segmentos pertencentes a cada dispositivo orientados em direções 
opostas. 

FIGURA 3.13 - Layout de um par diferencialna configuração centróide comum 

Para blocos com transistores de tamanhos maiores, os transistores geralmente 
são divididos em segmentos, ou seja, "quebrados" para permitir a construção de um 
layout compacto (o que reduz significamente as resistências de porta do par casado). Os 
tipos mais simples de layout envolvem o posicionamento de múltiplos segmentos em 
paralelo. Se estes segmentos forem interdigitados corretamente, então os centróides dos 
dispositivos casados estarão alinhados em um ponto no meio do eixo de simetria do 
layout. A figura 3.14 mostra um exemplo de um par diferencial casado com transistores 
de múltiplos segmentos em paralelo. 

FIGURA 3.14 - Layout de um par diferencial na configuração centróide comum com transitares 
"quebrados" 

A qualidade de um layout de transistores casados somente pode ser analisada 
com certeza após a fabricação. Uma análise mais detalhada só pode ser realizada através 
de uma boa caracterização do processo de fabricação. Desta maneira, o projetista 
analógico teria informações especificas sobre questões importantes para o pareamento e 
poderia utilizá-las no momento da implementação do layout. 



3.8 Conclusão 

Neste capitulo foram tratados os subcircuitos considerados básicos para o 
projeto de circuitos analógicos CMOS, com as caracteristicas elétricas de cada um, as 
quais serão base para o projeto de blocos analógicos mais complexos como 
amplificadores operacionais e comparadores. 

Os subcircuitos analisados foram: chave CMOS, resistores ativos, espelho de 
corrente, par diferencial e inversor CMOS. A fim de ilustrar todo processo de análise 
de um subcircuito analógico, assim como as caracteristicas deste bloco em questão, 
foram descritas a análise e projeto de um estágio diferencial usando par diferencial 
NMOS. A partir da modelagem AC e DC desenvolvida no capitulo anterior, foi 
implementada uma metodologia de projeto. Foram obtidos resultados de performance 
do estágio diferencial, calculados analiticamente e através de simulações elétricas, 
comprovando que esta metodologia convencional, ainda bastante usada em projeto 
analógico, é suficiente, obtendo-se uma primeira aproximação para o projeto de um 
circuito. 

As principais técnicas de layout usadas na implementação dos blocos analógicos 
analisados anteriormente também foram analisadas. Os blocos construtivos básicos mais 
importantes para o projeto analógico, o par diferencial e espelho de corrente, utilizam 
transistores MOS casados. Portando foram discutidas técnicas de layout para casamento 
de transistores como a técnica centróide comum, onde os centróides dos dispositivos 
casados são alinhados em um ponto no meio do eixo de simetria do layout. 



4 Metodologia de projeto baseada na curva gm/ID 

A maioria dos métodos para sintese de circuitos analógicos geralmente considera 
que os transistores MOS operam em inversão forte ou em inversão fraca, que muitas 
vezes não é uma boa solução para se obter resultados seguros. A metodologia de projeto 
gm/iD, proposta por [FLA 961 [SIL 961, apresenta um método alternativo para este 
problema, permitindo uma metodologia de sintese unificada considerando todas as 
regiões de operação do transistor MOS. 

Neste método é considerada a relação entre a caracteristica gm/ID (razão entre a 
transcondutância gm sobre a corrente de dreno ID) e a corrente de dreno normalizada 
ID/(W/L) como parâmetro fundamental para o projeto. A escolha da relação gm/ID é 
baseada nas seguintes considerações: 

É fortemente relacionada à performance dos circuitos analógicos; 
Indica a região de operação do dispositivo; 
Fornece uma ferramenta para o cálculo das dimensões dos transistores 

A relação da razão g J 1 ~  com a região de operação do transistor pode ser 
observada pelo fato que sua razão é igual a derivada do logaritmo de ID com respeito a 
VG como é mostrada abaixo: 

/ 

A derivada é máxima na região de inversão fraca, onde é igual a l/jnUt), onde n 
é o slope factor e Ut a thermal voltage, e mínima quando o ponto de operação se move 
para a região de inversão forte. Portanto, dá uma boa indicação da região de operação 
do transistor. 

Outra interessante caracteristica desta metodologia é que tanto a relação gm/ID 
como a corrente normalizada ID/(W/L) são independentes em relação as dimensões dos 
transistores. Portando, pode-se considerar que a relação entre gm/iD e a corrente 
normalizada é uma caracteristica única para todos os transistores do mesmo tipo 
(NMOS e PMOS) para uma determinada tecnologia. 

Portando, pode-se obter uma curva com esta caracteristica universal de gm/iD 
versus iD/(W/L) que pode ser explorada durante o projeto, onde as dimensões dos 
transistores são desconhecidas. A partir das especificações desejadas para um 
determinado bloco analógico, e uma vez que um par de valores gm e ID forem obtidos 
(escolha da região de operação do transistor pelo projetista), o W/L do transistor pode 
ser determinado. A figura 4.1 demonstra esta metodologia. 



Especificações . gm/lD - ID/(W/L) 
do projeto 

1 + 
ID WIL 

W L 

FIGURA 4.1 - Procedimento para o uso da metodologia g,/ID 

4.1 A Curva g m / i ~  

A curva &ID versus ID/(W/L) pode ser obtida por duas maneiras: 
analiticamente, utilizando-se um modelo para o transistor MOS, ou através de medidas 
experimentais de um transistor típico. A tecnologia usada neste trabalho é a 
AMS0.35pm portanto a curva gm/ID foi obtida para esta tecnologia. Todos os 
parâmetros de processo da tecnologia foram obtidos através do modelo BSIM3v3. 

4.1.1 Curva gm/ID analítica 

Para se obter a curva gm/ID analiticamente, é necessário o uso de um modelo para 
o transistor MOS que forneça uma representação contínua da corrente do transistor com 
os seus parâmetros de pequenos sinais em todas as regiões de sua operação. O modelo 
EKV [ENZ 971 fornece a seguinte equação que modela todas as regiões do transistor: 

1 1-e  (Em) 
g m  - - -. - 

I ,  n.Ut E (Eq. 0.15) 

IC = I ,  
W (Eq. 0.16) 

2 . n . p . C o x . . U t Z  
L 

onde IC é o coeficiente de inversão, n é o slope factor e Ut a thermal voltage. 
Substituindo a equação 4.2 na equação 4.3, e isolando a variável iD/(W/L), obtêm- 

se a seguinte equação: 

E Jm 1-e  ut.\l= 
g,,, / I D  = 

?I (Eq. 0.17) 



Para a obtenção da curva gm/ID através da equação descrita anteriormente, é 
necessário o conhecimento de importantes parâmetros de processo, como n, Ut, po, 
Cox, já previamente apresentados na seção 2.3. A figura 4.2 mostra a curva gm/ID obtida 
analiticamente para os transistores NMOS e PMOS da tecnologia AMS0.35pm. 

FIGURA 4.2 - Curva &/I, analítica dos tramitares NMOS e PMOS para a tecnologia AMS035pm. 

4.1.2 Curva gm/iD simulada 

Para a obtenção da curva gm/ID experimental, seriam necessárias várias medidas 
de transistores típicos para a tecnologia aqui em uso. Como ainda não se possui 
dispositivos físicos para a caracterização nesta tecnologia, a solução encontrada foi a 
obtenção da curva através de simulações elétricas Spectre com o modelo BSIM3v3. 

Para a obtenção da curva foi seguido o seguinte procedimento: 

a curva ID x VG, com VD = 3,3V e Vg = OV é obtida via simulação de um 
transistor de WL=1 (W=lOpm, L=lOpm); 
é calculado ln(1~) de cada ponto; 
é calculada a derivada de ln(1~) em relação a VG para cada ponto (equação 4.1); 
é plotado gm/ID versus ID/(W/L); 
o mesmo procedimento é repetido para o transistor PMOS de WL=1, com as 
tensões de polarização invertidas. 

A figura 4.3 mostra a curva gm/ID obtida através de simulação elétrica dos 
transistores NMOS e PMOS para a tecnologia AMS0.35pm. 



FIGURA 4.3 - Curva &/ID simulada dos transistores NMOS e PMOS para a tecnologia AMS035pm. 

4.1.3 Curva g,/iD: analitica versus simulada 

Com a obtenção das curvas g,/iD analítica e simulada para a tecnologia 
AMS0.35pm o próximo passo é a decisão de qual solução usar para o projeto. Afigura 
4.4 mostra a comparação entre as curvas gm/iD obtidas analiticamente e através de 
simulação elétrica dos transistores NMOS e PMOS para a tecnologia AMS0.35pm. Para 
um ajuste melhor das duas curvas foi necessário um ajuste fino (na região de inversão 
moderada) do parâmetro n na curva analítica (~NMOS = 1,2 e npMos = 1,3). 
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FIGURA 4.4 - Curva &/ID: analítica e simulada dos transitares NMOS e PMOS para a tecnologia 
AMS035pm. 



A solução ideal seria o uso da curva obtida através de medidas experimentais em 
transistores desta tecnologia. Como não se dispõe em laboratório dos dispositivos 
físicos necessários para a caracterização nesta tecnologia, optou-se pelo uso da curva 
obtida através de simulações elétricas Spectre com o modelo BSIM3v3, considerando 
que este modelo é confiável. 

4.2 Conclusão 

Neste capítulo é analisada a metodologia de projeto gm/I~, uma metodologia de 
síntese unificada considerando todas as regiões de operação do transistor MOS. Neste 
método considera-se a relação entre a razão da transcondutância gm pela corrente 
unitária de dreno ID e a corrente de dreno normalizada ID/(W/L) como a ferramenta 
fundamental para o projeto. 

A curva gm/iD versus iD/(W/L) para a tecnologia AMS0.35pm foi obtida por 
duas maneiras: analiticamente, usando o modelo EKV para o transistor MOS, e através 
de simulações elétricas Spectre de um transistor típico de canal longo (W=lOpm e 
L=lOpm). Considerando que o modelo elétrico disponível é confiável, escolheu-se 
curva simulada como padrão para o projeto dos blocos analógicos a serem 
implementados neste trabalho. 

Com a curva gm/ID obtida para a tecnologia desejada, o próximo passo é a 
aplicação e validação desta metodologia. O próximo capítulo tratará da análise e projeto 
de alguns blocos analógicos considerados básicos para construção da maioria dos 
sistemas analógicos usados atualmente: o amplificador Miller, o comparador track-and- 
latch e um filtro passa-banda contínuo no tempo. 



5 Aplicação da metodologia gm/ID na análise e projeto 
de módulos analógicos 

Neste capítulo, a metodologia estudada será aplicada na análise e projeto de 
alguns circuitos considerados básicos para construção da maioria dos sistemas 
analógicos usados atualmente: amplificadores, comparadores e filtros analógicos. 
Primeiramente, será descrito o projeto do amplificador operacional tipo Miller de dois 
estágios. Logo após, será descrita a análise de blocos amplificadores e comparadores, 
visando a aplicação em um sistema analógico, o Modulador Sigma-Delta Passa-Banda 
[NOR 971. Toda esta análise será baseada na tecnologia AMS0.35pm utilizando os 
parâmetros típicos fornecidos pela foundry. 

5.1 Amplificador Miller 

A fig. 5.1 mostra o esquemático do amplificador operacional Miller. Este 
circuito consiste em dois estágios: o primeiro é um estágio diferencial com par 
diferencial PMOS e o segundo é um estágio inversor que funciona com carga ativa. 
Este importante circuito analógico tem esta denominação porque utiliza a versão mais 
simples da técnica da compensação "Miller" [ALL 20021. Esta técnica é aplicada 
conectando-se um capacitor da saída (Cc) do circuito á entrada do segundo estágio 
amplificador. A função deste capacitor de compensação é separar ainda mais os pólos 
do amplificador de modo a evitar que o circuito se tome instável (compensação Miller). 

-L 
VSS 

FIGURA 5.1 - Esquemático do amplificador tipo Miller 

A partir da análise do comportamento DC e da análise AC, através de seu 
modelo de pequenos sinais mostrado na figura 5.2, deste bloco pode-se obter as 
principais equações que modelam seu comportamento baseado na análise feita em [ALL 
20021. A tabela 5.1 mostra as equações que modelam o comportamento do amplificador 
Miller, onde as caracteristicas em AC e DC são detalhadas. 



FIGURA 5.2 - Modelo de pequenos-sinal., simplificado amplificador Miller 

I / 

TABELA 5.1 - Equações que modelam o compodamento amplificador Miller 

+ + 

- - 

- 

(pólo dominante) g,, . (r02 11 r04). (r0611 r07). Cc 

+ 
-- 

vout 
*- CL 

- 

~2 
(pólo de segunda ordem) 

CL 
Garantia para MF = 60" 

8,7 2 10.gm1 
Slew rate (SR) I 5  

- 

Cc 
Ganho DC (Av) gm, . (r02 / /  ro4). gm, . (r06 / /  ro7) 

Produto ganho-faixa (GBW) R,, 
- ~ 

Vin máximo (CMR+) VDD - V,,. - v,. 
Vin mínimo (CMR-) "' + 'GS3 + 'SDl - 'SGl 

Deseja-se obter um amplificador Miller com as seguintes especificações 
(baseadas em especificações de amplificadores operacionais comerciais): Av > 10000 
(SOdB), GBW = 15MHz, MF = 60°, VCMR = - lV  a 0,5V, SR > 18V/us, CL = lOpF, 
VDD = 1,65 V e VSS=-1,65 V. 

Primeiro, é necessário estabelecer o valor do capacitor de compensação Cc. 
Como regra básica [ALL 20021, o pólo dominante de saída do circuito deve ser 
posicionado a 2,2 vezes o GBW, o que garante uma margem de fase de 60" (assumindo 
que o zero do semiplano direito z, é maior que 10 vezes o GBW). Tal posicionamento 
do pólo resulta na seguinte expressão para o valor para Cc 

O procedimento do projeto, baseado em [ALL 20021 [SIL 961, é ilustrado aqui 
buscando melhor performance em termos de ganho DC (Av), Margem de Fase (MF), 
produto ganho-faixa (GBW) e slew rate (SR). Entretanto, este procedimento pode ser 
modificado levando em conta outros aspectos (como ruído e CMR - rejeição de modo 
comum) que podem ser relevantes para um determinado tipo de aplicação, desde que 
esteja diretamente ligado com relação ~,/ID versus iD/(W/L). 

Esta metodologia é graficamente ilustrada na figura 4.1, mostrada anteriormente. 
O projeto segue a seguinte seqüência: 



a partir da especificação de S R  pode-se obter a corrente de polarização (IDM~), 
que é igual a 45pA. 
os transistores do espelho de corrente NMOS (M3 e M4) devem operar na região 
de inversão forte, a fim de se garantir um bom casamento e boas propriedades de 
ruído. Portanto, é escolhido (gm/ID)3 = (gm/iD)4 = 10; 
para o par diferencial NMOS (M1 e M2), a partir da especificação de GBW 
pode-se saber o g, dos transistores do par, e consequentemente seu gm/iD. 
Portanto, (g,/I~)i = 10,47; 

a partir da relação g,, 2 10. g,, [ALL 20021, tem-se que (gm/iD)í = 10; 

Com os valores de g,/iD escolhidos, a corrente normalizada iD/(W/L) é 
determinada através da curva gm/iD de cada transistor, e consequentemente o W/L de 
cada transistor. O comprimento de canal (L) é determinado a fim de se obter uma 
melhor relação entre área e ganho DC (devido á dependência da tensão de Early em 
relação ao L, como é mostrado na seção 3.2), aqui estimado em 5 vezes o L mínimo que 
a tecnologia permite. Os valores escolhidos são mostrados na tabela 5.2. 

TABELA 5.2 - Dinensões dos transistores - Amplificador Miller 

A tabela 5.3 mostra excelentes resultados de performance do amplificador 
Miller, calculados analiticamente e através de simulações elétricas Spectre, nas versões 
esquemático e com o seu layout extraído. O layout do amplificador projetado, mostrado 
na figura 5.3, foi feito no ambiente CADENCE usando as técnicas de layout descritas 
no capítulo 3. 

TABELA 5.3 - Resultados de perfomance do Amplificador Miller calculados e simulados 

Analítico Simulação Spectre 
Esquemático Layout Extraído 

Av (dB) 107,45 90,09 81,99 
F-3d~ (&) 543 1,037K 

MF r) 60 54.3 5 5 
GBW(MHz) 15 15,14 14,6 

SR (Vlps) 18 20,7 20,42 

IDD (PA) 280,6 356 346,9 
Pdiss (mW) 0,925 1,17 1,144 
Vout ,,(V) 0,5 1 1 
Vout ,i, (V) - 1 -1,48 -1,47 



FIGURA 5.3 - Layout do amplificador tipo Miller AMS035pm 

A fim de se demonstrar o potencial desta metodologia também são comparados 
com resultados obtidos através de uma metodologia de projeto convencional baseada 
em [ALL 20021. A tabela 5.4 mostra a comparação das dimensões dos transistores 
obtidas e a tabela 5.5 mostra comparações de alguns resultados de performance 
simulados eletricamente (com o simulador Spectre) em cada metodologia. A 
metodologia convencional modela o transistor MOS, usando equações Spice nível 1, 
considerando que o transistor está sempre na região de saturação (ver seção 2.2). 

TABELA 5.4 - Comparação das dimensões dos transistores calculados via metodologia convencional e 
&/I, - Amplificador Miller 

Metodologia Metodologia 
Convencional gm/i~ 
[ALL O21 



A tabela 5.5 mostra a comparação entre os resultados de performance do 
amplificador Miller (ambos na versão esquemático), utilizando as duas metodologias 
diferentes. Pode-se obsenrar claramente a vantagem da metodologia gm/ID na otimização 
do projeto na topologia de um amplificador Miller, pois se obtêm o ganho DC (Av) e 
produto ganho-faixa (GBW) similares aos obtidos usando a metodologia convencional 
utilizando-se 35% menos corrente, e conseqüentemente consumindo menos potência. 
Porém estes resultados podem variar em função da variação das especificações 
requeridas. 

TABELA 5.5 - Comparação de resultados de performance simulados do Amplificador Miller com 
metodologia convencional e &/I, 

Metodologia Metodologia 
Convencional ~ I D  - 

[ALL O21 

(gmlI~)i 10,69 10,47 
(W/L)i 42 36 
(gm/ID)3 6,33 10 
(W/L)3 5 10 

Av (dB) 90,85 90,09 

MF (O) 5 5 54,3 
GBW (MHz) 16 15,14 

SR (Vlps) 19,2 20,7 
IDD (IA) 510,5 356 

Pdiss (mW) 1,68 1,17 
Vout má, (V) 0,996 1 
Vout ,i, (V) -1,5 -1,47 

5.2 Blocos construtivos de um modulador Sigma-Delta passa-banda 

Atualmente, conversores AID e DIA sobre-amostrados são bem populares, pois 
proporcionam aplicações de velocidade pequenalmédia com alta resolução, tais como 
áudio de alta qualidade e telecomunicações. Nestes conversores o sinal analógico é 
amostrado a uma taxa significativamente acima da banda de sinal. A principal razão 
para esta popularidade é que conversores sobre-amostrados podem "relaxar" nas 
especificações na parte analógica, permitindo que toda a filtragem e tratamento do sinal 
sejam realizados pela parte digital do conversor. 

Conversores AID baseados em modulação sigma-delta (CA) [NOR 971 
combinam taxas de amostragem bem acima da taxa de Nyquist com simplicidade de 
hardware. Primeiro, o sinal analógico é modulado em um código simples, uma 
seqüência de palavras de 1 bit, em uma freqüência bem maior que a taxa de Nyquist 
(quantização). Depois, o estágio decimador transforma o sinal modulado em palavras 
maiores a uma taxa de amostragem menor, removendo também ruído e interferência 
[AZI 961 [NOR 971. 

Moduladores CA são atualmente usados em diversas aplicações. Além de serem 
implementados facilmente com pequena área e potência, são relativamente insensíveis 
ás imperfeições do circuito e ao casamento entre componentes, podendo operar com alta 
resolução, mostrando-se eficientes em proporcionar uma grande faixa de funções de 
processamento sobre um sinal. O modulador CA consiste em um filtro analógico e um 





5.3 Comparador Track-and-Latch 

O comparador é um importante bloco funcional analógico. Ele compara um 
sinal analógico com outro sinal analógico (referência), resultando em um sinal binário 
baseado nesta comparação. Um comparador de tensão pode ser considerado como um 
circuito não-linear similar ao amplificador operacional operando a laço aberto. Devido 
ao alto ganho, dependendo dos sinais de entrada, a saída fica sempre saturada ou no 
nível alto (VDD) ou no nível baixo (VSS). Um comparador ideal pode ser descrito pelos 
mesmos parâmetros de um amplificador operacional, com ganho finito, sendo 
necessário alguma variação de tensão de entrada para se alterar a saída [ALL 20021. 

A figura 5.5 mostra o diagrama de blocos do circuito comparador escolhido para 
análise: o comparador track-and-latch [CHO 20011 [KOB 931. Ele consiste em um 
estágio comparador controlado por um relógio seguido de um circuito digital Latch, que 
serve para manter o sinal comparado anteriormente durante o mesmo ciclo de relógio. A 
seguir será descrito a análise e projeto de cada um destes blocos. 

Vicornpn 

Vicornpp 

L - - - . - - i - . - - - i - ' - - . - - . k - ' - - * f - . . - - . - - . . :  

Vdd Vss phil ph12 

FIGURA 5.5 - Diagrama de blocos do comparador track-axd-latch 

5.3.1 Comparador 

O estágio comparador escolhido é um circuito amplificador diferencial que 
detecta pequenas variações de tensão. Ele funciona, basicamente, por controle de 
corrente, apresenta baixo consumo estático e é imune a variações de tensão de 
alimentação [KOB 931. 

O comparador, mostrado na figura 5.6, consiste em um par diferencial NMOS 
(M1 e M2), dois inversores realimentados (M3/M8 e M4/M9), dois transistores PMOS 
pull-up de reset (M6/M7) e uma fonte de corrente controlada por um relógio (M5). 
Durante o semi-ciclo ativo do relógio, os transistores pull-up ficam "abertos" e o par 
diferencial é ativado, onde os sinais de entrada devem estar definidos e estáveis, 
realizando-se a comparação. No semi-ciclo inativo, a corrent 1s é cortada e os nodos de 
saída são resetados (pré-carga). Por esta razão consome muito menos potência que um 
comparador convencional. 

O seu desempenho depende, principalmente, do ganho do amplificador 
diferencial, isto é, da corrente de polarização do circuito. A realimentação positiva 
através dos inversores tem a função de aumentar a velocidade de regeneração e manter o 
sinal por algum tempo. 
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FIGURA 5.6 - Comparador chaveado 

5.3.1.1 Análise e Projeto 

Deseja-se obter um comparador com as seguintes especificações: sensibilidade 
de 5mV, frequência de operação de lOMHz, SR = 100V/ps, CL = 100fF (carga de 
entrada do estágio seguinte, Latch D), VDD = 1,65 V e VSS=-1,65 V. 

A partir da análise dos comportamentos DC e AC (através de seu modelo de 
pequenos-sinais), deduziram-se as principais relações que modelam seu comportamento. 

Primeiramente, pode-se obter a corrente de polarização 15 do comparador. 
Considerando a carga de saída do comparador CL = 100fF (carga de entrada do estágio 
seguinte, Latch D) e um slew rate SR = 100V/ps, obtêm-se 15 

I5 
SR = - 3 I5 = 100M (Eq. 0.19) 

C ,  

A partir da corrente, pode obter-se, então, o (WIL) do transistor M5 

A seguir, é feita uma análise de pequenos sinais do comparador. Observando-se 
a figura 5.7, pode-se notar que a variação da corrente no par diferencial (AI) é que irá 
ditar o funcionamento do comparador. A partir desta obsenração pode-se obter duas 
equações importantes que ditam o funcionamento do comparador: 

AI = GM,,dif. Vin (Eq. 0.21) 



onde GM,, dz. é o ganho de trancondutância gm do par diferencial e Vin a tensão de 
entrada a ser comparada (sensibilidade do comparador), e 

Vo = r03 . A i  ( ~ q .  0.22) 

onde r03 é a resistência de saída do estágio inversor e Vo a tensão de saída comparada. 

I 

FIGURA 5.7 - Modelo de pequenos-sinais simplificado do comparador 

A partir destas duas relações pode-se obter as dimensões do par diferencial e do 
estágio inversor. A seguir, cada um deste blocos é analisado separadamente. 

Estágio inversor: 

Fazendo uma análise de pequenos sinais do estágio inversor, mostrado na figura 
5.8, durante o funcionamento do comparador, a equação 5.5 é obtida. 

L 
VSS 

FIGURA 5.8 - Estágio inversor do comparador 



I I I  

r03 +T3 A 

- - vo = -Al.r03 

FIGURA 5.9 - Análise de pequenos sinais simplificado do inverso da figura 5.8 

Considerando-se um AI de 5%, ou seja, AI = 2,5pA, e que a tensão de saída 
(output swing) excursiona entre VDD e VSS (variação de 3.3V), pode-se obter ro3. 

A partir de ro3, pode-se obter a tensão de Early (VA) do transistor 

VA = ro3. I = 1,3W!J. 5 0 4  3 VA = 66V (Eq. 0.24) 

E a partir de VA pode-se obter o L dos transistores do estágio inversor (ver 
capítulo 3), L = 2,5pm. 

O ( W L )  dos transistores deste estágio foram calculados para suportar uma 
corrente de 50pA (1512) na região de saturação (modelo SPICE nível 1). 

Estágio par diferencial: 

A partir da equação 5.4, pode-se obter o ganho de transcondutância g,,, dos 
transistores do par diferencial. Considerando-se o mesmo AI de 5%, ou seja, AI = 

2,5pA, e uma sensibilidade (Vin) de 5mV, obtêm-se 

GM 
par = , 54 u/l GMpar = 0,0005S ( ~ q .  0.25) 

Vin 5mV 



A partir de gm pode-se obter o (WL) dos transistores do par diferencial usando 
a curva gm/iD . 

g,/I, = 10 + curva &/I, + (WIL) = 22 ( E ~ .  0.26) 

Os transistores de pull-up (M6 e M7) só funcionam durante o estágio de pré- 
carga, sendo uma chave puramente digital. Portanto, foram dimensionados com W e L 
mínimos da tecnologia. 

A partir de simulações Spectre iniciais do layout extraído do estágio 
comparador, constatou-se que a sensibilidade (AVin) e a variação da tensão de modo- 
comum deixavam a desejar (valores baixos). Portanto foi necessário um ajuste no 
projeto, uma realimentação na análise do projeto para se buscar uma solução. 

A solução encontrada foi o aumento das dimensões (WL) dos transistores do 
par diferencial, ou seja, analisando-se a equação 5.4 para um mesmo AI, baixou-se pela 
metade a sensibilidade desejada, dobrando-se as dimensões do par diferencial, deixando 
o par diferencial mais sensível ás variações de corrente. 

GM 25p4 Par = , 
3 GMpar = 0,001s ( ~ q .  0.27) 

Vin 2,5mV 

A partir de gm pode-se obter o novo (WIL) dos transistores do par diferencial 
usando a curva gm/iD. 

g,/I, = 20 + &/I, + (WL) = 44 (Eq. 0.28) 

A partir da análise feita pode-se obter uma tabela com o dimensionamento dos 
transistores do comparador. O comprimento de canal (L) é determinado a fim de se 
obter uma melhor relação entre área e ganho DC (devido á dependência da tensão de 
Early em relação ao L, como é mostrado na seção 3.2). Os valores escolhidos são 
mostrados na tabela 5.6. 

TABELA 5.6 - Dimensões dos transitares - Comparador 

W/L w (Pm) L (Pm) 
M1 44 66 1,5 
M2 44 66 1,5 
M3 2,4 6 2,5 
M4 2,4 6 2,5 
M5 0,277 1,25 4,5 
M6 3,33 1 0 3  
M7 3,33 1 0 3  
MS 0,s 2 2,5 
M9 0,s 2 2,5 



5.3.1.2 Implementação 

Com as dimensões obtidas partiu-se para a etapa de implementação utilizando-se a 
ferramenta CADENCE. O circuito foi implementado em duas versões: esquemático 
(utilizando a biblioteca de transistores AMS0.35) e layout (extraído com capacitâncias). 

A figura 5.10 mostra o layout do estágio comparador na tecnologia AMS0.35um, 
com uma área total de 53 x 25 wmZ . 

FIGURA 5.10 - Layout do Comparador em tecnologia AMS035pm 

5.3.1.3 Resultados de simulação 

A fim de se validar o projeto, foram realizadas diversas simulações Spectre, em 
versões esquemático e layoutlextraído. 

Foram realizados 3 ensaios para se caracterizar a performance do estágio 
comparador., conforme descrito a seguir. 

ENSAIO 1 (Sensibilidade): 

- Aplica-se uma tensão senoidal de 100KHz na entrada positiva do comparador, e 
aterra-se a entrada negativa; 

- Freqüência de relógio de 10MHz; 
- CL = 50iF (emulando a carga de saída do comparador - Latch D). 



A partir deste ensaio pode-se obter a sensibilidade, freqüência máxima do 
relógio, e corrente de operação. A figura 5.11 ilustra o ensaio feito em ambiente Spectre 
CADENCE e a tabela 5.7 mostra os resultados obtidos. 

FIGURA 5.11 - Configuração do ensaio 1 em ambiente Spectre CADENCE -  comparado^ 

TABELA 5.7 - Resultados de simulação para o emaio 1 - Comparador 

Esauemático LavoutíExtracão 

F,,,k phi 1 ( M H z )  40 40 
Itail (pA) 63,5 65 

A figura 5.12 mostra o comportamento da corrente Itail do transistor M5 na 
versão esquemático do comparador. A operação chaveada do comparador faz com que 
um pico de corrente significativo ocorra imediatamente após a ativação do relógio (phil 
= low + high ). 

FIGURA 5.12 - Comportamento da corrente do transitar M5 (Itail) na versão esquemático do 
comparador. 



ENSAIO 2 (Atraso): 

- Aplica-se uma tensão onda quadrada de 2MHz na entrada positiva do 
comparador, e aterra-se a entrada negativa; 

- Frequência de relógio de 10MHz 
- CL = 50iF (emulando a carga de saída do comparador- Latch D). 

A partir deste ensaio pode-se obter o atraso (tempo de propagação) do 
comparador. A figura 5.13 ilustra o ensaio feito em ambiente Spectre CADENCE e a 
tabela 5.8 mostra os resultados obtidos. 

FIGURA 5.13 - Configuração do ensaio 2 em ambiente Spectre CADENCE -  comparado^ 

TABELA 5.8 - Resultados de simulação para o emaio 2 - Comparador 

Esquemático LayoutExtração 
Amplitude I 10 I 5 0  I 1 0  I 5 0  

ImV) ,--- . , 
Td,, Td, Td,, Td, Td,, Td, Td,, Td, 
(ns) (ns) (ns) (ns) ( 4  (ns) (ns) (ns) 

Phil + 5,lO 10,60 5,15 8,63 5,14 9,68 5,20 7,88 
Vo+comp 
Phil + 5,12 10,54 5,15 8,40 5,14 9,61 5,21 7,66 

Vo-comp 

ENSAIO 3 (Modo-comum): 

- Aplica-se uma tensão onda triangular na entrada positiva do comparador com 
uma amplitude de I 3mV + Vx , e a entrada negativa com uma tensão DC Vx. A 
partir daí varia-se a tensão de modo-comum Vx. 

- Frequência de relógio de 10MHz 
- CL = 50iF (emulando a carga de saída do comparador - Latch D). 



A partir deste ensaio pode-se obter a variação da tensão de saída em relação á 
variação da tensão de modo-comum. A figura 5.14 ilustra o ensaio feito em ambiente 
Spectre CADENCE e a tabela 5.9 mostra os resultados obtidos. 

FIGURA 5.14 - Configuração do ensaio 3 em ambiente Spectre CADENCE - Comparador 

TABELA 5.9 - Resultados de simulação para o emaio 3 - Comparador 

Esquemático LayoutlExtração 
Variação da saída em relação I 500mV I350mV 
á tensão de modo-comum (V) 

Máxima variação da tensão de saída (V) +1,63 / -1,44 +1,62 / -1,53 

5.3.2 Latch D 

Após o estágio comparador é necessário um estágio Latch D. Enquanto o 
comparador amostra o sinal, o estágio Latch deve manter o sinal comparado 
anteriormente durante o mesmo ciclo de relógio. 

Este circuito é um simples circuito digital Latch D, como é mostrado figura 5.15, 
composto por duas portas NOR2, duas portas NOR3 e dois buffers de saída para que o 
circuito suporte uma carga de 10pF. 

FIGURA 5.15 - Esquemático em podas lógicas do circuito Latch D 



Os transistores foram dimensionados de acordo com os procedimentos e 
recomendações para projeto de circuitos digitais. A tabela 5.10 mostra a relação das 
dimensões escolhidas para os transistores que operam em modo digital (grandes-sinais). 

TABELA 5.10 - Dimensões dos transitares - Latch D 

W L  w (Pm) L (Pm) 
NOR2 NMOS 20 6 0 3  

PMOS 40 12 0 3  
NOR3 NMOS 10 3 0 3  

PMOS 20 6 0 3  
INV1 NMOS 50 15 0 3  

(Buffer) PMOS 100 30 0 3  
INV2 NMOS 200 60 0 3  

(Buffer) PMOS 400 120 0 3  

Com as dimensões obtidas partiu-se para a etapa de implementação e validação 
do circuito, utilizando-se a ferramenta CADENCE. O circuito foi implementado em 
duas versões: esquemático (utilizando a biblioteca de transistores AMS0.35) e layout 
(extraído com capacitâncias).A figura 5.16 mostra o layout do Latch D na tecnologia 
AMS0.35um. Simulações elétricas Spectre foram realizadas a fim de se avaliar 
performance do circuito. A tabela 5.11 mostra estes resultados. 

FIGURA 5.16 - Layout do circuito Latch D em tecnologia AMS035pm 



TABELA 5.11 - Resultados de s ~ u i a ç ã o  do iayout do circuito Latch D, F = 10MHz - CL= IOpF, Área 
= 5 0 x 5 2 p m 2  

Atraso - philb + Q Atraso - philb + Qb 
T ~ H L  (ns) 1,42 1,38 
T ~ L H  (ns) 1,s 1,87 
IDD (mA) 36,68 

Pdiss (mW) 121,04 

5.3.3 Circuito completo - Comparador + Latch D 

Com os 2 blocos caracterizados, partiu-se para a implementação do comparador 
track-and-latch completo, mostrado na figura 5.5. O circuito foi implementado em duas 
versões: esquemático (utilizando a biblioteca de transistores AMS0.35) e layout 
(extraído com capacitâncias). A figura 5.17 mostra o layout do comparador track-and- 
latch na tecnologia AMS0.35um, com uma área total de 78 x 50 pmZ. 

-I 
FIGURA 5.17 - Layout do circuito comparador track-axd-latch em tecnologia AMS035pm 

A fim de se validar o projeto, foram realizadas diversas simulações Spectre do 
circuito completo. A seguir, é descrito o ensaio para se caracterizar a performance do 
circuito. 

ENSAIO : 

- Aplica-se uma tensão senoidal de 100KHz na entrada positiva do comparador, e 
aterra-se a entrada negativa. 



- Freqüência de relógio de 10MHz 
- CL = 10pF 

A partir deste ensaio pode-se obter a caracterização das formas de onda do 
comparador. A figura 5.18 ilustra o ensaio feito em ambiente Spectre CADENCE, 
enquanto a figura 5.19 mostra o funcionamento do circuito com as formas de onda das 
tensões Vo+ - ext (saída do estagio comparador - layout/extraído) e Q e x t  (saída final do 
comparador após o Latch - layoui/extraído). 

-7.69 i 

FIGURA 5.18 - Configuração do ensaio do circuito total em ambiente Spectre CADENCE 

FIGURA 5.19 - Formas de onda das tensões In+ (tensão senoidal de entrada), Vo+ext  (saída do estagio 
comparador -layout/extraído) e Q-ext (saída final do comparador após o Latch) obtida via simulação 

elétrica Spectre do circuito Comparador + Latch D 



5.4 Filtro GM-C Passa-Banda 

Filtros analógicos são sistemas analógicos muito importantes, bastante usados 
em sistemas de comunicação. Um filtro analógico pode ser definido como uma rede de 
componentes (resistores, capacitores, indutores e transistores) que opera ou processa 
sinais elétricos analógicos [LAK 941. O termo filtro ativo se refere ao filtro que usa 
componentes ativos (transistores) ou circuitos amplificadores em seus esquemáticos. 

Existem várias maneiras de se implementar um filtro analógico ativo em um 
circuito integrado (CI). Todas elas se baseiam em circuitos com amplificadores 
operacionais e uma rede RC passiva, para que o sistema realimentado resulte na função 
de transferência desejada. Além de serem pouco compatíveis com a tecnologia de CIs 
dominante, CMOS (onde resistores não são normalmente disponíveis ou são difíceis de 
se implementar), estes circuitos necessitam de amplificadores de alto ganho e largura de 
banda elevada, o que dificulta e encarece o seu projeto. 

A arquitetura usando filtros Transcondutância-C (GM-C) [LAK 941 [SCH 200 11 
[TSI 941, é uma boa opção para o projeto de filtros contínuos no tempo. Comparando-se 
com outras implementações, consomem menos potência, são mais rápidos e possuem 
maior capacidade de atingir freqüências maiores [SCH 20011. Esta arquitetura evita o 
uso de amplificadores operacionais, obtendo o ganho que se necessita através de 
amplificadores transcondutores. Portanto só é necessário para sua implementação 
capacitores e transcontudores, facilitando a sua implementação em circuitos integrados. 

Filtros GM-C vêm sendo usados em diversas aplicações como vídeo digital, 
filtros IF, etc., [ELH 20011 [SAN 20001, obtendo faixas de freqüência de poucos KHz a 
várias centenas de MHz. Portanto, esta arquitetura foi escolhida para a implementação 
do filtro analógico passa-banda contínuo no tempo. 

O bloco construtivo básico desta arquitetura é o amplificador de 
transcondutância (OTA), que pode ser considerado como uma fonte de corrente 
controlada por tensão. Portanto, pode-se considerar que o bloco transcondutor como um 
simples amplificador diferencial, um circuito analógico relativamente simples de se 
implementar, onde as suas técnicas de projeto foram extensivamente estudadas e 
caracterizadas nos capítulos anteriores. 

Esta célula de transcondutância, representada aqui pelo símbolo mostrado na 
figura 5.20, gera uma corrente de saída proporcional a uma diferença de tensão de 
entrada, como mostra a equação abaixo. 

10 = gm ' (E+ - ) (Eq. 0.29) 

Vi- Vi- - 

FIGURA 5.20 - Símbolo do bloco básico transcondutor: (a) circuito single-ended; (b) circuito diferencial. 



5.4.1 Blocos transcondutores construtivos elementares 

A fim de ser construir filtros GM-C, necessitam-se de vários blocos construtivos 
elementares. Como o próprio nome "filtros GM-C" sugere, se deseja empregar 
capacitores e transcondutores como componentes básicos. Portanto, os componentes 
necessários para o projeto de filtros, como resistores, indutores e integradores podem ser 
implementados através destes dois componentes básicos. A seguir a implementação de 
cada um destes componentes é descrita. 

5.4.1.1 Resistores 

Resistores são componentes bastante importantes no projeto de filtros analógicos 
integrados. Porém são difíceis de se implementar com uma relativa exatidão, para uma 
faixa de valores adequada em circuitos integrados. 

Pode-se simular um resistor simplesmente conectando-se o terminal de saída 
negativo de um transcondutor com o seu terminal de entrada positivo, como mostra a 
figura 5.21a. Como a entrada do transcondutor é (idealmente) um circuito aberto, a 
corrente de entrada Ii é igual a corrente de transcondutância de saída 10, então 

Conseqüentemente, o circuito representa um resistor: 

Vi 1 R=-=- 
(Eq. 0.31) 

Ii g ,  

FIGURA 5.21 - Resitor aterrado simulado com um transcondutor: (a) circuito single-ended; (b) circuito 
diferencial. 

É importante salientar que esta configuração simula um resistor aterrado, pois Vi 
é referenciado ao terra, e a entrada diferencial invertida do transcondutor está aterrada. 
Para se realizar um resistor flutuante, as tensões de entrada e saída (com a realimentação 
sempre negativa) são referenciadas aos terminais em que se deseja simular o resistor. 



5.4.1.2 Integradores 

A partir da implementação de um transcondutor com uma impedância de saída 
Z(s), como é mostrado na figura 5.22, e usando um capacitor C como sua impedância, 
obtém-se a seguinte resposta 

que implementa o bloco construtivo fundamental de filtros GM-C: o integrador GM-C. 

Vi- - 
Vo- 

FIGURA 5.22 - Integrador GM-C: (a) circuito single-ended; (b) circuito diferencial 

Esta configuração converte a tensão diferencial de entrada Vi em uma corrente 
pelo transcondutor, esta corrente é então integrada em C gerando a tensão de saída Vo. 
Este tipo de circuito, assim como os filtros que usam este circuito, são chamados de 
"modo tensão". Estas são as estruturas tratadas neste trabalho. Outro tipo de 
configuração, o chamado circuito "modo corrente", integra a corrente de entrada Ii em 
C para gerar a tensão e saída, que depois é convertida novamente em corrente pelo 
transcondutor. 

A figura 5.22b mostra um integrador diferencial com o capacitor conectado entre 
as duas saídas diferenciais do circuito, o que economiza área para a implementação do 
capacitor. Porém esta implementação tem uma grande desvantagem, pois na fabricação 
de capacitores integrados, pode haver um capacitor parasita (devido a proximidade com 
o substrato) cujo tamanho pode ser de até 10% do valor do capacitor. Portanto, muitas 
vezes é interessante converter este capacitor em dois capacitores aterrados (porém com 
o dobro do valor) como mostra a figura 5.23, eliminando a influência dos parasitas. 

FIGURA 5.23 - Conversão de capacitores em circuitos diferenciais. 



5.4.1.3 Gyrators 

O gyrator, um bloco de dois terminais onde a sua impedância de entrada é 
inversamente proporcional a sua impedância de carga, é um elemento muito útil na 
implementação de filtros GM-C, pois possibilita a conversão de um capacitor em um 
indutor. Por ser fundamentalmente uma conexão entre uma fonte controlada por tensão 
inversora e uma não-inversora [SCH 20011, o projeto de gyrators é bem simples usando 
transcondutores. 

Considerando a configuração mostrada na figura 5.24a, um gyrator é 
caracterizado pelas equações 

E através destas duas equações deriva-se 

- - - .- 
V0 (Eq. 0.34) 

' i  g m i  . g m 2  

e considerando que a impedância de saída é C, obtém-se um indutor 

L = (Eq. 0.35) 
g m i  ' g m 2  

FIGURA 5.24 - Indutor aterrado simulado com um transcondutor: (a) circuito single-ended, (b) circuito 
diferencial. 



5.4.2 Topologia filtro GM-C passa-banda biquad 

Filtros usando a técnica GM-C empregam fundamentalmente os mesmos 
métodos de circuitos ativos RC. Então, pode-se obter uma topologia de um filtro GM-C 
passa-banda a partir do circuito passivo RLC mostrado na figura 5.25. 

FIGURA 5.25 - Filtro passa-banda RLC passivo 

A partir deste circuito, pode-se obter a sua implementação usando 
transcondutores como é mostrado na figura 5.26: gmi converte a tensão de entrada em 
corrente, gmz representa o resistor R, o capacitor C1 representa C, e gm3 e gm4 formam o 
gyrator (onde o capacitor C2 implementa o indutor L). 

FIGURA 5.26 - Topologia filtro GM-C passa-banda diferencial biquad. 

Esta implementação de segunda ordem (biquad) emula diretamente o circuito 
RLC passivo mostrado na figura 5.25 obtendo a seguinte função de transferência: 

g m l  -. S  
v0 - - - - C1 
Vi 2 g m 2  + g m 3  ' g m 4  ( ~ q .  0.36) 

S  + S . -  
C1 Cl.C2 

onde 

wc = 
C1. g m 3  . g m 4  /= C1.C2 e Q = /; g m 2  

(Eq. 0.37) 

Wc representa a freqüência central do filtro (WC = 2 .  iz . FC)  , e Q é o fator de 
qualidade do filtro. 



5.4.2.1 Topologia modificada 

A partir da topologia biquad obtida anteriormente, pode-se obter uma topologia 
simplificada, retirando o estágio gmz e modificando a saída como mostra a figura 5.27. 
Considerando que todos os transcondutores são iguais gm= gmi= gm3= gm4, e C=Cl=C2, 
pode-se obter a seguinte função de transferência 

- - - - - 

vi 2 (Eq. 0.38) 
2 g m  

S +- 
C 

onde 

FIGURA 5.27 - Topologia filtro GM-C passa-banda diferencial, obtida a parbr da configuração biquad 

Vi+ \ 2C 
í ,2CI 

++ - + - +  
m' @" @" 

Esta configuração além de economizar um transcondutor fornece um fator de 
qualidade (Q) infinito. Porém, considerando que o transcondutor é um elemento real e 
possui uma condutância de saída Go, a função de transferência do filtro é modificada 

vo- 
--to 

onde 

wc = 
C 

(Eq. 0.41) 

+ - - - + -  - +-c4 . 
Vi- 

É interessante notar que nesta configuração o fator de qualidade do filtro 
depende diretamente da resistência da saída do transcondutor. 

vo+ 



5.4.3 Implementação do filtro 

Deseja-se implementar a topologia do filtro GM-C passa-banda diferencial para 
uma aplicação específica [FAB 20031, mostrado na figura 5.27, com as seguintes 
especificações: freqüência central de operação Fc = 5MHz e um fator de qualidade Q > 
50. Portanto, a partir das equações 5.24, e com C = IpF, tem-se o ganho de 
transcondutância do OTA 

A configuração diferencial foi escolhida, pois qualquer interferência ou ruído 
nas tensões de entrada será eliminado pela simetria do circuito. 

O próximo passo é a escolha do bloco transcondutor, pois o projeto de filtros 
GM-C está ligado diretamente a esta escolha. Um amplificador de transcondutância 
ideal para este tipo de aplicação seria uma fonte de corrente controlada por tensão com 
largura de banda infinita e resistências de entrada e saída infinitas. A seguir será 
descrito o projeto do filtro passa-banda usando duas arquiteturas de transcondutores 
diferentes. 

5.4.3.1 Bloco transcondutor: amplificador diferencial 

Como primeira opção, considerou-se a configuração simples estágio 
amplificador diferencial com CMFB (Common-Mode FeedBack) [LAK 941, mostrado 
na figura 5.28. Além de consumir pouca potência, é um circuito relativamente simples 
de se implementar, onde as suas técnicas de projeto foram estudadas e caracterizadas 
nos capítulos anteriores. 

FIGURA 5.28 - OTA com estágio amplificador diferencial e CMFB 
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A partir o filtro a ser implementado, deseja-se obter um amplificador diferencial 
com as seguintes especificações: g,i = 64,84pS (g,i=g,/2), SR > 25V/us, CL = IpF, 
VCMR = +0,5V, Rout > 4MR (para se obter um Q mínimo de 50), VDD = 1,65 V e 
VSS=-1,65 V. O procedimento do projeto busca melhor performance nas especificações 
acima. Todas as características DC e AC do circuito são calculadas a partir da 
modelagem para o transistor MOS descrita no capítulo 2. O projeto segue a seguinte 
seqüência: 

a partir da especificação de SR, pode-se obter o limite minimo para a corrente de 
polarização: I,, > SR.C, 3 I,, = 2 5 d ;  

para o par diferencial NMOS (M1 e M2), a partir da especificação de ganho de 
transcondutância, pode-se saber o seu ~,/ID 

as dimensões dos transistores do espelho de corrente PMOS (M3 e M4) são 
calculados a partir da especificação de VCMR,,: 

V,,, = 0,625V 3 - = - = 2 ;  (71, (71, 
a dimensão do transistor M5 é calculado a partir da especificação de VCMR,,: 

V,,, = 0 , 4 0 7 3  - = 3,5; (71, 
O circuito CMFB consiste dos transistores M6 a MIO, e pode ser considerado 

também com um amplificador. Este circuito serve para manter estável a tensão se saída 
de modo-comum. Seus transistores foram dimensionados segundo os seguintes critérios 
baseados em [LAK 941: GBWCM $ GBWdif , a fim de se garantir condições de 
polarização estável em todas as freqüências de interesse; o amplificador diferencial 
deve operar sob uma tensão de entrada de modo-comum máxima. 

A tabela 5.12 mostra a relação dos tamanhos dos transistores para este projeto. O 
comprimento de canal (L) é determinado a fim de se obter uma melhor relação entre 
área e ganho DC , devido á dependência da tensão de Early em relação ao L (como é 
mostrado na seção 3.2). A tabela 5.13 mostra os resultados de performance do circuito, 
através de simulações elétricas Spectre usando o modelo BSIM3v3.2.2. 

TABELA 5.12 - Dinensões dos transistores Amplificador diferencial 

W/L w ( ~ 4  L ( ~ 4  
M1 1,67 8,35 5 
M2 1,67 8,35 5 
M3 3,6 18 5 



TABELA 5.13 - Resultados de sinulação elétrica Spectre Amplificador diferencial 

Rout (MR) 5 
GBW(MHz) 5,5 

SR (Vlps) 24 
MF (") 89,2 

Voutma, (V) 1,3 
Voutmi, (V) -0,9 

IDD (pA) 8233 
Pdiss (mW) 0,27 

Com o bloco transcondutor devidamente projetado e caracterizado, o próximo 
passo é a implementação do filtro GM-C passa-banda. A figura 5.29 mostra o 
esquemático do filtro implementado em ambiente CADENCE Spectre. Já a figura 5.30 
mostra os resultados da simulação em frequência do filtro. Considerando que a 
resistência de saída do transcondutor (11Go) é 5MR, pode-se considerar que o zero que 
este parâmetro produz na função de transferência do filtro, segundo a equação 5.23, está 
em uma frequência baixa em relação a Fc (aproximadamente 200KHz), podendo ser 
desconsiderada. Além disso, garante um fator de qualidade Q maior que 50. A tabela 
5.14 mostra os resultados de performance do filtro, obtidos pelas simulações elétricas 
Spectre. 

FIGURA 5 29 - Esquematico do filtro passa-bandaimplementado em ambiente CADENCE Spectre 
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FIGURA 5.30 - Resultados de simulação em freqüência do filtro passa-bandaimplementado 

TABELA 5.14 - Resultados de perfomance do filtro, obtidos pelas simulações elétricas Spectre 

Q 110 
IDD ( 0 4  247,4 

Pot (mW) 0.816 
Vout,, (V) 1 3  
vout,i, (V) - 1 
SR (Vlps) 10 

5.4.3.2 Bloco transcondutor: amplificador diferencial linearizado 

Um transcondutor é uma célula de transcondutância em que a corrente de saída é 
idealmente linear em relação a tensão de entrada. Portanto, a linearidade do 
transcondutor é uma questão muito importante no projeto de filtros GM-C. 

Considerando o par diferencial (previamente analisado no capítulo 3), que é o 
estágio de entrada mais conhecido e usado no projeto de transcondutores diferenciais, 
mostrado na figura 5.31. Com os seus transistores operando na região de saturação, o 
ganho de transcondutância g, do par diferencial é 



onde AVin = Vin, - Vin e Ai é a corrente AC. O que mostra claramente que a corrente 
de saída do transcondutor não é linear em relação a tensão de entrada. 

L 

FIGURA 5.31 - Estágio par diferencial: corrente de saída não é linear em relação a tensão de entrada 

Uma maneira simples de se linearizar este circuito é o uso da técnica de 
degeneração de fonte (source degeneration) [KAI 20011 [SAN 20001, mostrado a figura 
5.32, onde um resistor passivo é conectado entre os terminais de fonte do par 
diferencial. Portanto, o ganho de transcondutância g,,, do par diferencial é determinado 
pelo termo linear 

p.Cox W 
2.Ai 

- - 
aIb - 1 

g m  =- N- 

Avin a(~,, - vt) - po . cox w R (Eq. 0.44) 

FIGURA 5.32 - Estágio par diferencial linearirado 

O resistor R pode ser implementado através de um transistor com o seu terminal 
gate conectado a uma tensão de polarização (VC) como é descrito no capítulo 2. 



Considerando que o transistor está operando na região não linear (triodo), sua 
resistência é dada por 

R = 
1 

(Eq. 0.45) 
~ . C O X  W 

. ( V C  -vt3-VCM +vt2)  
n L 

onde 

Vin, - Vin- 
VCM = ( ~ q .  0.46) 

2 
A partir desta análise, o transcondutor diferencial projetado na seção anterior 

pode ser modificado, como mostra a figura 5.33. Para uma faixa de tensão baixa, a 
resistência pode ser ajustada através da tensão de porta VC do transistor M3. 

-L I 
VSS I 

Estágio diferencial linearizado I (IMFB 

I I a a 

FIGURA 5.33 - OTA com estágio amplificador diferencial linearizado e CMFB 

A tabela 5.15 mostra a relação dos tamanhos dos transistores para este projeto. 
Os transistores foram dimensionados para as mesmas especificações do projeto anterior. 
A tabela 5.16 mostra os resultados de performance do circuito transcondutor, através de 
simulações elétricas Spectre usando o modelo BSIM3v3.2.2. Observando-se a tabela 
6.5, nota-se que para uma determinada faixa de tensão VC, pode-se ajustar o valor da 
resistência do transistor M3, garantindo uma tensão de saída de modo-comum estável. 
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TABELA 5.15 - Dimensões dos transistores Amplif icador  diferencial l ineczado  

TABELA 5.16 - Resultados de simulação elétrica Spectre - Amplificador diferencial linearnado 

vc (v)  0,5 - 1,5 
(Faixa de linearidade) 

\ ,  

Vout,, (V) 1 3  
Vout,, (V) -0,9 

IDD (PA) 82,42 
Pdiss (mW) 0,27 

Com o novo bloco transcondutor devidamente projetado e caracterizado, partiu- 
se para a implementação do filtro GM-C passa-banda. O filtro passa-banda projetado foi 
implementado em duas versões: esquemático (utilizando a biblioteca de transistores 
AMS0.35pm) e layout (extraído com capacitâncias). A figura 5.34 mostra o 
esquemático do filtro implementado. O layout do circuito, mostrado a figura 5.35, foi 
feito no ambiente CADENCE usando as técnicas de layout descritas no capítulo 3. Os 
quatro capacitores de 2pF foram implementados com polisilício nível 1 - polisilício 
nível 2, e podem identificados pelos quatro retângulos maiores na figura 5.34. A área 
total é de 121 x 163 pm2. 

Já as figuras 5.36 e 5.37 mostram os resultados da simulação em frequência do 
filtro para as versões esquemático e layout extraído, respectivamente. Agora, a 
frequência central do filtro (Fc) pode ser ajustada pelo valor do ganho de 
transcondutância do OTA, que por sua vez está relacionado com o valor da resistência 
do transistor M3. Ou seja, para uma faixa de tensão baixa que garanta que M3 funcione 
na região triodo, a frequência central do filtro (Fc) pode ser ajustada através da tensão 
de polarização VC. 



FIGURA 5.34 - Esquemático do filtro passa-banda com Fc ajustável implementado em ambiente 
CADENCE Spectre 

FIGURA 5.35 - Layout do filtro passa-banda com Fc ajustável implementado em ambiente CADENCE 
Spectre - Área total de 121 x 163 pm2 



AC Response 

FIGURA 5.37 - Resultados de simulação p m a  ajuste de freqüência do f d t o  passa-banda implementado - 
Versão layout extraido. 

FIGURA 5.36 - Resultados de simulação p m a  ajuste de frequência do f d t o  passa-banda implementado - 
Versão esquemático. 
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Considerando que a resistência de saída deste transcondutor (11Go) é de 
aproximadamente lOMR, pode-se considerar que o zero que este parâmetro produz na 
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função de transferência do filtro, equação 5.23, está em uma freqüência baixa em 
relação a Fc (aproximadamente lOOKHz), podendo ser desconsiderada. 

È interessante notar que existe também uma variação do fator de qualidade Q de 
acordo com VC, devido a dependência de Q (eq. 5.24) do ganho de transcondutância g, 
e da resistência de saída dos blocos transcondutores que implementam o filtro. Porém o 
valor de Q se mantém dentro da especificação desejada (> 50). 

A tabela 5.17 mostra os resultados de performance do filtro, obtidos pelas 
simulações elétricas Spectre. 

TABELA 5.17 - Resultados de performance do filtro passa-banda com Fc ajustável, obtidos pelas 
simdações eléhicas Spectre 

IDD (pA) 247,65 25 1,4 
Pot (mW) 0,817 0,829 

 VOU^,, (V) 1 0,9 
Voutmin (V) -1 -0,9 

5.5 Conclusão 

Neste capítulo, a metodologia de projeto g,/ID, assim como as técnicas de 
projeto e modelagem desenvolvidas anteriormente, é aplicada na análise e projeto de 
diversos blocos analógicos. 

O primeiro circuito analisado foi o amplificador operacional tipo Miller. A partir 
dos valores de g,/ID escolhidos, a corrente normalizada iD/(W/L) foi determinada 
através da curva gm/iD de cada transistor, e conseqüentemente o W L  de cada transistor 
para as especificações desejadas. Também foram obtidos resultados através de uma 
metodologia de projeto convencional baseada em na análise do capítulo 3 para posterior 
comparação. 

Como exemplo de um sistema analógico a ser implementado usando esta 
metodologia, foi apresentado o Modulador Sigma-Delta Passa-Banda. Uma simples 
arquitetura de um Modulador CA passa-banda contínuo no tempo de primeira ordem é 
composta por um estágio filtro passa-banda e um comparador, além da realimentação 
através de um DIA de 1 bit. Foram analisados e projetados os módulos que compõem 
este importante sistema: o comparador track-and-latch e filtro passa-banda. 

O comparador track-and-latch foi projetado através de uma extensa análise dos 
comportamentos DC e AC (através de seu modelo de pequenos-sinais), baseada nas 
análises contidas nos capítulos anteriores. Observou-se que a variação da corrente no 
par diferencial (AI) do estágio comparador dita o funcionamento do comparador. A 
partir desta observação obteve-se as dimensões dos transistores. Simulações Spectre 
foram realizadas para este bloco, para a validação do projeto e obtenção das 
características elétricas. Os dados de desempenho foram tabelados. 

No projeto do filtro passa-banda, uma topologia de um filtro GM-C biquad 
diferencial foi desenvolvida a partir de um circuito passivo RLC. A configuração 
diferencial foi escolhida, pois qualquer interferência ou ruído nas tensões de entrada é 
eliminado pela simetria do circuito. Como o projeto de GM-C está ligado diretamente a 



esta escolha do bloco transcondutor, foram implementados filtros usando duas 
arquiteturas de transcondutores diferentes. A primeira implementação usou a 
configuração de um simples estágio amplificador diferencial com CMFB, com 
resultados de performance do filtro obtidos por simulações elétricas, obtendo-se uma 
frequência central (Fc) de 5,2 MHz e um fator de qualidade Q de 110, atendendo as 
especificações desejadas. 

A segunda implementação do filtro usou o mesmo estágio diferencial com 
CMFB, usando a técnica de degeneração de fonte (source degeneration) para se 
linearizar o transcondutor. Esta configuração de filtro, além de possuir o bloco 
transcondutor, linearizado, tem a sua frequência central ajustável por uma pequena faixa 
de tensão que garante o transcondutor com o seu ganho de transcondutância linear. Os 
resultados de performance do filtro foram obtidos por simulações elétricas, obtendo-se 
uma frequência central (Fc) entre 4 e 5 MHz e um fator de qualidade Q de 250, 
atendendo as especificações desejadas. 

Comparando-se as duas implementações do filtro, mostra-se claramente a 
vantagem da segunda implementação, pois a linearidade do transcondutor é uma 
questão muito importante no projeto de filtros GM-C. Além disso, é interessante ao 
projetista poder fazer um ajuste "fino" na frequência central do filtro, ou até no seu fator 
de qualidade. É importante salientar também que, como este trabalho visa analisar, 
caracterizar e exercitar técnicas de projeto de sistemas analógicos, escolheu-se uma 
topologia simples (e bastante usada) para o filtro, assim como os seus blocos 
transcondutores. 



6 Conclusões 
Neste trabalho foi realizado um estudo sobre técnicas de projeto, analisando 

fatores importantes como modelagem e caracterização de parâmetros de tecnologia, 
para o desenvolvimento de alguns blocos analógicos considerados básicos para 
construção da maioria dos sistemas analógicos usados atualmente - amplificadores, 
comparadores e filtros analógicos. 

A partir das regras elétricas e regras de layout para a tecnologia a ser usada 
(AMS0.35pm), foi feita a análise do transistor MOS. Foi analisado um modelo 
simplificado para se calcular a corrente do transistor MOS usado em modelos Spice 
nível 1, e a partir disto foi revisada a modelagem AC e DC do transistor MOS, que 
emulam o funcionamento deste dispositivo. A partir desta modelagem, os parâmetros de 
tecnologia que descrevem as caracteristicas particulares do transistor MOS foram 
analisados. A maioria dos parâmetros elétricos para a tecnologia AMS0.35pm foi obtida 
a partir do modelo elétrico disponível, o modelo BSIM3v3.2.2. 

Também foram descritos os processos de obtenção de dois parâmetros elétricos 
muitos importantes para o projeto analógico, n (fator de inclinação) e VA (tensão de 
Early). Para a obtenção do valor do fator de inclinação n foram usados três métodos, 
porém o método baseado em um modelo desenvolvido para circuitos analógicos (EKV) 
onde o parâmetro equivale ao inverso da derivada de Vp em relação a VGB foi 
considerado o melhor deles. O parâmetro VA foi caracterizado a partir do efeito de 
diminuição do comprimento eletricamente efetivo do canal por VDS (curva ID versus 
VDS) do transistor. A relação da variação da tensão de Early em função da variação L e 
VGB para o transistor foi obtida, dando mais liberdade ao projetista escolher o L do 
transistor a fim de se obter o estágio de um circuito com a resistência de saída desejada. 
Também se obteve a caracteristica da variação VA em relação a região de operação do 
transistor, ou seja, em função da variação da caracteristica gm/ I~  do transistor para 
diversos comprimentos de canal diferentes. 

Com uma modelagem confiável, os subcircuitos considerados básicos para o 
projeto de circuitos analógicos CMOS (chave CMOS, resistores ativos, espelho de 
corrente, par diferencial e inversor CMOS) foram analisados. Foram descritos a análise 
e projeto de um estágio diferencial, ilustrando a análise e projeto de um circuito 
analógico, assim como as caracteristicas deste bloco em questão. A partir da modelagem 
AC e DC desenvolvida, foi implementada uma metodologia de projeto baseada nesta 
modelagem. Foram obtidos resultados de performance do estágio diferencial, calculados 
analiticamente e através de simulações elétricas, comprovando que esta metodologia 
"convencional", ainda bastante usada em projeto analógico, é eficaz, obtendo-se um 
projeto confiável. Também as principais técnicas de layout usadas na implementação 
dos blocos analógicos analisados anteriormente foram discutidas, a fim de se obter o 
layout de pares diferenciais e espelhos de corrente com transistores casados. 

Uma metodologia de síntese unificada considerando todas as regiões de 
operação do transistor MOS, a metodologia de projeto gm/iD, foi discutida. Este método 
considera a relação entre a razão entre a transcondutância gm sobre a corrente de dreno 
ID e a corrente de dreno normalizada iD/(W/L) como a ferramenta fundamental para o 
projeto. A curva gm/iD versus iD/(W/L) para a tecnologia AMS0.35pm foi obtida por 
duas maneiras: analiticamente, usando o modelo EKV para o transistor MOS, e através 
de simulações elétricas Spectre de um transistor típico. Considerando que o modelo 
elétrico disponível é confiável, escolheu-se a curva simulada como padrão para o 
projeto dos blocos analógicos a serem implementados neste trabalho. 



Para a validação desta metodologia, foram desenvolvidos a análise e projeto de 
alguns blocos analógicos muito usados em diversas aplicações. Primeiramente, o 
amplificador operacional Miller foi analisado. Foram obtidos ótimos resultados de 
simulações elétricas na performance do amplificador Miller, observando-se a vantagem 
da metodologia gm/iD, pois além de dar uma boa indicação da região de operação do 
transistor, fornece uma característica única para todos os transistores do mesmo tipo 
para uma determinada tecnologia. 

A partir de toda a análise feita anteriormente, blocos analógicos mais complexos 
foram analisados. O comparador track-and-latch e o filtro passa-banda GM-C biquad 
contínuo no tempo, foram implementados. O projeto de cada bloco foi baseado nas 
análises contidas nos capítulos anteriores. Simulações Spectre foram realizadas para 
cada bloco, para a validação do projeto e obtenção das caracteristicas elétricas. Os 
dados de desempenho foram tabelados. 

Mesmo com pouca experiência no projeto de um sistema analógico CMOS, 
conseguiu-se alcançar satisfatoriamente os objetivos propostos neste trabalho utilizando 
conceitos e métodos simples. Porém para que estes resultados sejam estendidos para o 
nível de implementação física diversas considerações devem ser feitas, como a validade 
do modelo elétrico usado e as caracteristicas do processo de fabricação (capacitância e 
resistências parasitas). Além disso, simulações adicionais devem ser feitas para se 
quantificar a sensibilidade dos parâmetros de desempenho em relação a variações de 
temperatura, alimentação e variações randômicas nos parâmetros elétricos e de processo 
(simulação Monte Carlo). Análises de ruído e THD (Distorção Harmônica Total) 
também serão consideradas posteriormente para completar a validação dos blocos 
projetados. 

Outra importante consideração é a escolha do comprimento de canal L dos 
transistores. Como todas as metodologias de projeto fornecem a relação WL, fica a 
critério do projetista a escolha do L. Neste trabalho, o L é determinado a fim de se obter 
uma melhor relação entre área e ganho DC, devido á dependência da tensão de Early 
em relação ao L. Nos módulos analógicos desenvolvidos, estimou-se em 5 vezes o L 
mínimo que a tecnologia permite (em alguns casos, escolheram-se valores maiores a fim 
de se aumentar o ganho DC). Fatores importantes como área (WxL), ruído e velocidade 
não foram considerados. Portanto, pretende-se desenvolver uma metodologia específica 
para a escolha do L, levando-se em conta fatores como área, ruído e velocidade 

Como trabalho futuro, pretende-se prototipar os circuitos projetados, junto com 
diversos transistores de teste. Isto possibilitará a validação através de medidas elétricas 
dos circuitos implementados, completando o ciclo de projeto de um sistema analógico. 
Assim, os parâmetros de projeto discutidos neste trabalho, como a curva gm/ID versus 
ID/(W/L) e a tensão e Early, poderão ser obtidos experimentalmente. Além disso, a 
partir de medidas elétricas dos transistores de teste, os parâmetros do modelo elétrico 
EKV, por exemplo, podem ser obtidas para posterior comparação com o modelo usado. 



Anexo 1 Modelo Spectre BSIM3v3.2.2 para o 
transistor MOS - Tecnologia AMS0.35pm 

/I k e r :  Austria Mikro Systeme 
/I HIT-Kit: Digital 
// . . . . . . . . . . . . . . . . . . . . . . . .  SIM"LATION PARAMETERS . . . . . . . . . . . . . . . . . . . . . . . .  
// ...................................................................... 
/I fomat : Spectre (Spectre Direct) 
/I model : MOS BSIM3v3 
/I process : CSADFI 
/I revision : NIC; 
/I extracted : CSAC61417; 1998-10; ese(487) 
/I doc# : 9933016 REVNIC 
// ...................................................................... 
/I TYPICAL MEAN CONDITION 
// ...................................................................... 
/I 
inline subckt modn ( d g s b ) 
parameters w 1 0 e - 6  1=10e-6 nrd=0.0 m = 0 0  ad=O.O as=O.O pd=O.O ps=O.O 
/I 
modn ( d g s b ) mosinsub w=w 1=1 nrd=nrd nrs=nrs ad=ad as=as pd=pd ps=ps 
model mosinsub bsim3v3 version=3.l type=n capmod=2000e+00 \ 

mobmod=1000e+00 nqsmod=0000e+00 noimod=1.000e+OO \ 
kl=6044e-01 \ 
k2=2945e-03 k3=-172e+00 k3b=6325e-01 \ 
nch=2310e+17 &0=4655e-01 \ 
voff=-572e-02 dvt0=2227e+01 dvtl=1051e+00\ 
dvt=3393e-03 keta=-621e-04 \ 

pscbel=2756e+08 pscbe2=9645e-06 \ 
dvtOw=0.000e+00 dvtlw=O.OOOe+OO dvt2w=O.O00e+OO \ 

ua=1000e-12 ub=1723e-18 uc=5756e-ll \ 
u0=4035e+02 \ 

dsub=5000e-01 eta0=3085e-02 etab=-395e-02 \ 
nfactor=l119e-01 \ 

em=4100e+07 pch=6831e-01 \ 
drout=5000e-01 \ 

a0=2208e+00 al=O.OOOe+OO a2=1000e+00 \ 
pvag=O.OOOe+OO vsaF1178e+05 ags=2490e-01 b0=-176e-O8 bl=OOOOe+OO\ 
delta=l.OOOe-02 pdiblcb=2583e-01 \ 

pdiblcl=1076e-01 \ 
pdiblc2=1453e-03 \ 

w0=1184e-07 \ 
dlc=8285e-09 \ 
dwc=2676e-O8 dwb=O.OOOe+OO dwg=O.OOOe+OO \ 
U=O.OOOe+OO 1w=0000e+00 lwl=0.000e+00 \ 

lh=l.OOOe+OO lm=1.000e+00 w1=0000e+00 \ 
wO.OOOe+OO ~ 1 = 0 . 0 0 0 e + 0 0  wh=l.OOOe+OO\ 

m = 1 . 0 0 0 e + 0 0  \ 
aF3300e+04 ute=-18Oe+00\ 

&I=-330e-01 kt=2200e-02 ktl1=0000e+00 \ 
ual=O.OOOe+OO ubl=O.OOOe+OO ucl=O.OOOe+OO \ 
pfi=O.OOOe+OO \ 
cgdo=2100e-10 cgso=2100e-10 cgbo=l. 100e-10 \ 
cgdl=O.OOOe+OO cgsl=O.OOOe+OO ckappa=6000e-O1\ 

cf=O.OOOe+OO eh=5000e+00 \ 
xparFl.OOOe+OO clc=l.OOOe-15 cle=6000e-01 \ 
rdsw6043e+02 \ 



cdsc=O.OOOe+OO cdscb=O.OOOe+OO cdscd=8448e-05 \ 
prwb=O.OOOe+OO p1wg=0.000e+00 cit=l.OOOe-03 \ 

tox=7700e-09 \ 
ngate=O.OOOe+OO \ 

nlx=1918e-07 \ 
A=5000e-O8 xwO.OOOe+OO \ 
af=1400e+00 kf=2810e-27 ef=l.OOOe+OO\ 

noia=lOOOe+20 noib=5000e+04 noic=-140e-12\ 
rd=O.OOOe+OO rs=O.OOOe+OO rsh=8200e+01\ 

min=l.OOOe-03 \ 
rdc=O.OOOe+OO rsc=O.OOOe+OO lmt=8285e-09 \ 

wint=2676e-O8 ldif=O.OOOe+OO hdif=6000e-07 \ 
xj=3000e-07 js=2000e-05 \ 
n=1000e+00 \ 

dslap=no t l e ~ O  tlevc=O \ 
cj=9300e-04 cjsw2800e-10 \ 
fc=O.OOOe+OO fcsw=O.OOOe+OO \ 
mj=3100e-01 mjsw=1.900e-01 \ 
pb=6900e-01 pbsw9400e-01 

ends modn 

/I k e r :  Austria Mikro Systeme 
/I HIT-Kit: Digital 
// . . . . . . . . . . . . . . . . . . . . . . . .  SIM"LATION PARAMETERS . . . . . . . . . . . . . . . . . . . . . . . .  
// ...................................................................... 
/I fomat : Spectre (Spectre Direct) 
/I model : MOS BSIM3v3 
/I process : CSADFI 
/I revision : NIC; 
/I extracted : CSAC61417; 1998-10; ese(487) 
/I doc# : 9933016 REVNIC 
// ...................................................................... 
/I TYPICAL MEAN CONDITION 
// ...................................................................... 
/I 
inline subckt modp ( d g s b ) 
parameters w 1 0 e - 6  1=10e-6 nrd=0.0 m = 0 0  ad=O.O as=O.O pd=O.O ps=O.O 
/I 
modp ( d g s b ) mosinsub w=w 1=1 nrd=nrd nrs=nrs ad=ad as=as pd=pd ps=ps 
model mosinsub bsim3v3 version=3.1 type=p capmod=2000e+00 \ 

mobmod=1000e+00 nqsmod=0000e+00 noimod=1.000e+OO \ 
kl=5675e-01 \ 
k2=-439e-02 k3=4540e+OO k3b=-852e-01 \ 
nch=l032e+17 &O=-617e-01 \ 
voff=-113e-01 dvt0=1482e+00 dvtl=3884e-O1\ 
da=-115e -02  keta=-256e-02 \ 

pscbel=lOOOe+09 pscbe2=1000e-OS\ 
dvtOw=0.000e+00 dvtlw=O.OOOe+OO dvt2w=O.O00e+OO \ 

ua=2120e-10 ub=8290e-19 uc=-528e-11 \ 
u0=1296e+02 \ 

dsub=5000e-01 eta0=2293e-01 etab=-392e-03 \ 
nfactor=8237e-01 \ 

em=4100e+07 pclm=2979e+00 \ 
drout=5000e-01 \ 

a0=1423e+00 al=O.OOOe+OO a2=1000e+OO\ 
pvag=O.OOOe+OO vsaF2000e+05 ags=3482e-01 b0=2719e-07 bl=OOOOe+OO\ 
delta=l.OOOe-02 pdiblcb=-178e-02 \ 

pdiblcl=3310e-02 \ 



wint=3845e-O8 ldif=O.OOOe+OO hdif=6000e-07 \ 
xj=3000e-07 js=2000e-05 \ 
n=1000e+00 \ 

dslap=no t l e ~ O  tlevc=O \ 
cj=1420e-03 cjsw3800e-10 \ 
fc=O.OOOe+OO fcsw=O.OOOe+OO \ 
mj=5500e-01 mjsw=3900e-01 \ 
pb=1020e+00 pbsw9400e-01 

ends modp 



Anexo 2 Arquivo Matlab da extração da curva &,/ID 
AMS0.35pm analítica (Modelo EKV) 

% Curva gm/ID vs ID/(W/L) 0.35um 
%Obtida do Modelo EKV 

% Constantes 
%nn = 1.33; 
nn = 1.2; 
%np = 1.45; 
np = 1.3; 
Uon = 403.5; %cm2/Vs 
Uop = 129.6; %cm2/Vs 
Tox = (7.700e-09)*100;%cm 
Eox = 3.45e-13; %F/cm 
Cox = Eox/Tox; %F/cm2 
k = 1.3807e-23; 
q = 1.602e-19; 
T = 300.15; 
Ut = k*T/q; 
%xl = le-9:le-8:0.01; 
xla=-l0:O.l:-2; 
xl=l0 .^xla; 

yl = (sqrt (2*nn*Uon*Cox) ./nn) . * (1-exp ( -  

sqrt(x1) ./(Ut.*sqrt(Z*nn*Uon*Cox) ) )  ) ./sqrt(xl); 
y2 = (sqrt (2*np*Uop*Cox) ./np) . * (1-exp ( -  

sqrt(xl)./(Ut.*sqrt(2*np*Uop*Cox))))./sqrt(xl); 

semilogx(xl,yl, 'r - ' ,  
xl,y2,'b - ' ) ;  
grid; 
ylabel('gm / ID') 
xlabel('ID/ (W/L) ' )  

gmsobreidn = input('Va1or de gm/ID curva NMOS: ' ) ;  
gmsobreidp = input('Va1or de gm/ID curva PMOS: ' ) ;  

disp('Resu1tados:'); 
texto = sprintf ('ID/ (W/L)n: %0.5g \nID/ (W/L)p: %0.5g \t',IDwln,I~lp); 



Anexo 3 Arquivo Matlab da extração da curva &,/ID 
AMS0.35pm simulada eletricamente 

% Curva gm/ID vs ID/(W/L) 0.35um 
close all; 
clear all; 

% Obtida via simulação Spectre 

% NMOS 
% Curva VG x ID 
% VD = 1.65V VB = OV 
IDn = [I;% Valores de tensão (VG) e corrente (ID) obtidos via 
simulacão 

% PMOS 
% Curva VG x ID 
% V D = - 1 . 6 5 V  V i =  OV 
IDp = [I ; %  Valores de tensão (VG) e corrente (ID) obtidos via 
simulacão 

IDp = -1Dp; 

VGn=IDn(:,l); 
IDna=log(IDn(:,2)); 
gmn=diff (IDna(:,l)) ./diff(IDn(:,l)); 
[al,bl]=max(gmn); 

VGp=IDp(:,l); 
IDpa=log(IDp(:,2)); 
gmp=diff(IDpa(:,l))./diff(IDp(:,l)); 
[aZ,bZ]=max(gmp); 

semilogx(IDn(bl:size(gmn),2),gmn(bl:size(gmn),l),'r', . . .  
IDp(b2:size(gmp),2),grnp(b2:size(gmp),l),'b') 
grid; 
ylabel('gm / ID') 
xlabel('ID/ (W/L) ' )  

gmsobreidn = input('Va1or de gm/ID curva NMOS: ' ) ;  
gmsobreidp = input('Va1or de gm/ID curva PMOS: ' ) ;  

disp('Resu1tados:'); 
texto = sprintf ('ID/ (W/L)n: %0.5g \nID/ (W/L)p: %0.5g \t',IDwln,I~lp); 
disp(texto) ; 



Anexo 4 Implementação e verificação de módulos 
analógicos no ambiente CADENCE - Tutoria1 

Este tutoria1 trata do procedimento para implementação e verificação de 
módulos analógicos no Ambiente CADENCE utilizando a tecnologia CMOS 0 . 3 5 ~  da 
empresa AMS. O circuito a ser implementado é um amplificador operacional do tipo 
Miller, previamente projetado no nível elétrico. 

A4.1 Amplificador Miller 

A figura A4.1 mostra o esquemático do amplificador operacional Miller. As 
dimensões W e L dos transistores foram obtidos através de uma metodologia de projeto 
previamente desenvolvida. A tabela A4.1 mostra as dimensões dos transistores para o 
projeto descrito na seção 4.2 desta dissertação. 

VDD 
-r 

m $2"" 'FI c[ 
m 
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FIGURA A 4  1 - Esquemático do amplificador operacional Miller 

Tabela P ,4. 1 - Dimensões dos transitares - Am~lificadoi 

W L  w (!JmLm) L (PLm) 
M1 36 54 1,5 
M2 36 54 1,5 
M3 10 15 1,5 



A4.2 Criando a biblioteca de um novo projeto no CADENCE 

No console de sua estação de trabalho digite o comando ams - cds -mode jb, 
automaticamente as janelas do ambiente icjb e Library Manager abrirão. 

Para começar a implementar em circuito analógico na ferramenta, é necessário 
criar uma nova biblioteca clicando a partir do Library Manager em File->New- 
>Library. Depois de preenchido o nome o projeto, clique em OK para continuar. 

FIGURA A 4  2 - Janela para criação de uma nova biblioteca de projeto 

Automaticamente após a criação do projeto, uma janela abrirá perguntando qual 
o arquivo de tecnologia deste novo projeto. Escolha a opção Attach to an existing 
techfile (figura A4.3). 
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FIGURA A 4  3 - Janela de configuração do arquivo de tecnologia de um novo projeto 

A seguir, outra janela abrirá para a escolha do arquivo de tecnologia (figura 
A4.4). Escolha a opção TECH CSI, que se refere á tecnologia AMS0.35pmLm, 
previamente configurada na etapa de configuração da ferramenta. 

Attach Design Library t o  Technolagy F i l e  
. , .  

OK ' Xancei 'Defaults ' Pyyily .. . 

I4e#:&$pi Li@i"d:q A m p l i f M i l l e i  

~~ ~ ~~ 

- TecRnolag$ tibtary i TECH-CSI -.= 

I - 
FIGURA A 4  4 - Escolhendo o arquivo de tecnologia de um novo projeto 

A4.3 Criando um esquemático de um circuito 

Com o projeto criado e sua tecnologia configurada, o próximo passo é a criação 
do esquemático de transistores do bloco a ser implementado. 

A partir do Library Manager e com nova biblioteca selecionada, clique em File- 
>New->Cell View. Uma janela de criação de um novo arquivo abrirá. No campo 
Library Name deve estar configurado a biblioteca que você criou, no campo To01 
escolha a opção Composer-Schematic que automaticamente irá configurar o campo 
View Name para a opção schematic. A figura A4.5 ilustra este procedimento. 
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FIGURA A 4  5 - Configurando o arquivo para a criação do esquemático de transitares do bloco a ser 
implementado 

A seguir, uma janela do módulo Virtuoso abrirá para a edição de um 
esquemático. Clique em Add->Instante, para acessar a biblioteca de transistores da 
tecnologia em uso, como mostra a figura A4.6. 

FIGURA A 4  6 - Criando o esquemático do circuito a partir da biblioteca de transistores da tecnologia em 
USO 

Para configurar as dimensões de cada transistor usado para compor o circuito, 
selecione o componente e clique com o botão do meio do seu mouse e selecione 
Properties (ou clique em Edit->Properties->Object). Automaticamente abrirá uma 
janela de edição das propriedades do componente da biblioteca. Nela você poderá 



escolher as dimensões nos campos Width (W) e Length (L) (Figura A4.7). Usando o 
mesmo procedimento é possível inserir outros componentes, como capacitores e fontes 
de alimentação. Os componentes são ligados via fios (Add -> Wire), como em qualquer 
editor de esquemático. 

Se desejar, você também pode "marcar" um nó com o nome que preferir. Para 
isso clique com o botão do meio do seu mouse e selecione a opção Add Name, digite o 
nome desejado, clique OK, e posicione sobre o nó que deseja "marcar". 

FIGURA A 4  7 - Configurando as propriedades do transistor 

Com o circuito montado, os pinos de entrada e saída do circuito devem ser 
criados. Clique em Add->Pin, escolha o nome e a direção do pino (figura A4.8) e ligue 
ao nó desejado. 
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FIGURA A 4  8 - Configurando os pinos de entrada e saída do esquemático 



Portanto, se pode obter o esquemático completo do amplificador Miller (com 
transistores, capacitor de compensação e pinos de entrada e saída), como é mostrado na 
figura A4.9. 

FIGURA A 4  9 - Esquemático completo do amplificador Miller 

A4.4 Criando um símbolo para o projeto 

Com o esquemático pronto, o próximo passo é a criação do símbolo para este 
circuito. Na mesma janela do módulo Virtuoso clique em Design->Creste Cell View- 
>From Cell View. Uma janela de criação de símbolo abrirá. No campo From View 
Name deve estar selecionada a opção schematic, no campo ToolUData Type escolha a 
opção Composer-Symbol que automaticamente irá configurar o campo To View Name 
para a opção símbolo. A figura A4.10 ilustra este procedimento. 
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FIGURA A 4  10 - Criando o símbolo do circuito 

Automaticamente, outra janela abrirá, onde você terá que dispor os pinos de 
entrada e saída de acordo com a preferência. A figura A4.11 ilustra este procedimento. 
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FIGURA A 4  11 - Dispondo os pinos do símbolo do circuito 

Edit mpertles i. 

Desse modo, uma nova janela abrirá com o símbolo criado para representar este 
circuito, com uma forma padrão quadrada. É possível também editar a forma deste. A 
figura A4.12 mostra o símbolo do amplificador Miller usado. 



FIGURA A 4  12 - Símbolo do amplificador Miller 

A4.5 Simulando o esquemático com o simulador elétrico Spectre 

Para a simulação elétrica das diversas versões de um circuito (esquemático, 
layout extraído) é necessária a criação de um novo projeto. 

Novamente a partir do Library Manager, clique em File->New->Library. 
Preencha o Nome do projeto simul e clique OK. Para escolher o arquivo de tecnologia, 
siga o mesmo procedimento descrito na seção A4.2. 

Com esta nova biblioteca selecionada, crie um novo esquemático de acordo o 
procedimento descrito na seção A4.3. Uma janela do módulo Virtuoso abrirá para a 
edição de um esquemático. Clique em Add->Instante, e selecione a biblioteca criada 
para o seu projeto, e no campo View selecione a opção symbol. Você poderá posicionar 
o símbolo do seu projeto neste novo esquemático. A figura A4.13 ilustra este 
procedimento. 
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FIGURA A 4  13 - Criando um novo esquemático para a sinulação de um circuito 



O próximo passo é a ligação das fontes de alimentação e cargas de saída do 
circuito. Clique em Add->Instame, para acessar a biblioteca de tecnologia em uso, 
como mostra a figura A4.14. Para acessar a biblioteca com as fontes de tensão (ou 
corrente) do circuito, na janela Library Manager - Add Instance selecione a opção 
Library: analogLib->Category: Sources->Independent. A seguir você poderá escolher 
o tipo de fonte que desejar (vdc, vsin, vpulse, etc). Para acessar a biblioteca com 
capacitâncias e resistores, selecione Library: analogLib-Xategory: Passives. Também 
é necessário colocar um nó de referência no circuito, ou seja aterrar as fontes e cargas. 
Para isso selecione a opção Library: basic -> Category: Suplies -> Cell: GND. 

FIGURA A 4  14 - Posicionando fontes e cargas do circuito pahr  da biblioteca da tecnologia em uso 

Para abrir o simulador elétrico Spectre, a partir do menu do Virtuoso selecione 
Tool->Analog Environment. Automaticamente a janela Affirma Analog Design 
Environment abrirá, como mostra a figura A4.15. 

O modelo BSIM3v3 da tecnologia AMS0.35pm deve estar configurado (o 
modelo pode ser mudado na etapa de configuração da ferramenta). Isto pode ser 
verificado selecionando a opção Setup -> Model Libraries. 
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FIGURA A 4  15 - Ambiente do simulador Spectre 

Primeiramente é necessária a configuração da referência do circuito. Selecione 
Setup->Stimul ..., e a janela Setup Analog Stimuli abrirá. No campo Stimulus Type 
selecione o campo Global Sources. O componente GND que você inseriu no 
esquemático deve aparecer. No campo DC Voltage, digite O, e no campo Source type 
digite dc. Depois clique na opção Enable e depois em Change (os campos Function e 
Type devem estar configurados como dc e voltage respectivamente). Agora a tensão de 
referência do seu circuito está configurada, como mostra a figura A4.16. 
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FIGURA A 4  16 - Configurando a referência do circuito 



Concluindo todos estes passos, o circuito está pronto para simulação. Tanto a 
janela do simulador, como a de edição do esquemático ficam abertas ao mesmo tempo, 
possibilitando a modificação dos elementos do circuito. De acordo com o tipo de 
análise elétrica que se deseja fazer do circuito, as fontes são modificadas assim como a 
configuração do simulador. 

No menu Analyses estão os comandos para a seleção do tipo de simulação a ser 
feita, AC, DC, transiente, análise de ruído, etc. 

No menu Variables, as variáveis definidas pelo usuário para as propriedades dos 
componentes usados podem ser configuradas. 

Para se iniciar uma simulação selecione a opção Simulation -> Netlist and Run. 
Para interromper uma simulação em andamento selecione Simulation -> Stop. 

A corrente e tensão nos nós do circuito podem ser analisadas e controladas pelos 
comandos no menu Outputs. Após a simulação, os sinais de corrente e tensão serão 
visíveis na janela Waveform Window. As formas de onda dos nós podem ser 
selecionadas diretamente do esquemático usando o botão esquerdo do mouse. Para 
selecionar tensão, clique no fio (wire) da conexão do nó desejado. Para selecionar 
corrente, clique no nó, ou seja, as caixas vermelhas, da conexão do nó desejado. 

Para melhor compreensão, a seguir são mostrados exemplos de três tipos básicos 
de análise elétrica para circuitos analógicos. A seguir, serão descritos os procedimentos 
de simulação de cada análise separadamente, assim como a configuração do circuito 
(aqui exemplificado como o amplificador Miller). 

A4.5.1 Análise DC 

Para se obter a caracteristica DC do amplificador, o circuito deve estar 
configurado da maneira como mostra a figura A4.17. 

FIGURA A 4  17 - Circuito configurado para análise DC 



No Affirma Analog Design Environment selecione Analyses -> Choose. 
Selecione a opção dc no menu Choosing Analyses. No campo Sweep Value selecione a 
opção Component Parameter (figura A4.18). 

Clique em Select Component para selecionar no esquemático a fonte de tensão 
que você deseja variar na simulação. Assim que você clicar com o botão esquerdo do 
mouse na fonte, uma nova janela abrirá (figura A4.19). Nela você deve escolher o 
parâmetro da fonte que deseja variar. Selecione a opção dc vdc "DC Voltage". 
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FIGURA A 4  18 - Configurando a análise DC do circuito 
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FIGURA A 4  19 - Selecionando o parâmetro variável da fonte para a análie DC do circuito 



Com o componente selecionado (neste caso a fonte de tensão V5), volte para o 
menu Choosing Analyses e no campo Sweep Range selecione a opção Start-Stop e 
forneça os limites máximo e mínimo dos valores de tensão da fonte (figura A4.20). No 
campo Sweep Type você pode determinar o passo de variação do parâmetro. 

FIGURA A 4  20 - Configuração da análise DC do circuito completa 

Agora o circuito está pronto para ser simulado. Para se iniciar uma simulação 
selecione a opção Simulation->Netlist and Run através do menu do Affirma Analog 
Design Environment. Assim que a simulação estiver completa, selecione Results-> 
Direct Plot -> DC. Depois selecione os nós que você deseja analisar (lembre-se: para 
selecionar corrente clique nas caixas vermelhas, para selecionar tensão clique no fio), e 
então clique em Esc. Automaticamente a janela Waveform Window abrirá com as 
formas de onda dos nós selecionados (figura A4.21). 

FIGURA A 4  21 -Análise DC do Amplificador Miller 



A4.5.2 Análise AC 

Para se obter a característica AC (em frequência) do amplificador, o circuito 
deve estar configurado da maneira como mostra a figura A4.22. 

FIGURA A 4  22 - Circuito configurado para análise AC 

Em uma das fontes vdc de entrada (V5), clique com o clique com o botão do 
meio do seu mouse e selecione Properties, no campo AC Magnitude digite 1 V (ou então 
um valor de tensão bem baixo, como 0,OlV) e no campo DC Voltage digite OV. A 
análise AC da tensão de saída, como a magnitude é lV, proporcionará o diagrama de 
Bode da função de transferência do circuito. 

No Afirma Analog Design Environment, selecione Analyses->Choose. 
Selecione a opção ac no menu Choosing Analyses. No campo Sweep Value selecione a 
opção Frequency (figura A4.23). No campo Sweep Range selecione a opção Start-Stop 
e forneça os limites máximo e mínimo dos valores de frequência. No campo Sweep 
Type você pode determinar o passo de variação do parâmetro. 



FIGURA 4.  23 - Configuração da análise AC do circuito completa 

Agora o circuito está pronto para ser simulado. Para se iniciar uma simulação 
selecione Simulation->Netlist and Run. Assim que a simulação estiver completa, 
selecione Results->Direct Plot ->AC Magnitude & Phase, selecione os nós que você 
deseja analisar (lembre-se: para selecionar corrente clique nas caixas vermelhas, para 
selecionar tensão clique no fio), e a seguir clique em Esc. Automaticamente a janela 
Waveform Window abrirá com o diagrama de Bode (Ganho e Fase) da função de 
transferência do amplificador (figura A4.24). Nesta opção, o valor do ganho é mostrado 
em unidades de dB (decibéis). 

FIGURA A 4  24 - Análise AC (diagrama de Bode) do Amplificador Miller 



A4.5.3 Análise transiente 

Para fazer uma análise do circuito no domínio tempo, a configuração mostrada 
na figura A4.25 é um bom exemplo. Como o amplificador operacional possui um ganho 
grande, o circuito é realimentado por um divisor de tensão para que a tensão de saída 
não sature. Neste exemplo uma das fontes de entrada do circuito (V5) deve ser uma 
fonte senoidal. Adicione uma fonte senoidal e clique com o botão do meio do mouse e 
selecione Properties, então configure a fonte como desejar (neste caso a fonte foi 
configurada com uma amplitude se 100mV e freqüência de 100KHz). 

FIGURA A 4  25 - Circuito configurado para análise transiente 

No Afirma Analog Design Environment, selecione Analyses -> Choose. 
Selecione a opção tran no menu Choosing Analyses. No campo Stop Time, digite o 
tempo de simulação desejado (figura A4.26). Para uma configuração mais detalhada, 
clique na opção Options, onde parâmetros como passo de simulação e ponto de 
operação podem ser configurados. 
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FIGURA A 4  26 - Configurando a análise transiente do circuito 

Agora o circuito está pronto para ser simulado. Para se iniciar uma 
simulação selecione Simulation -> Netlist and Run. Assim que a simulação estiver 
completa, selecione a opção Results -> Direct Plot -> Transient Signal. A seguir 
selecione os nós que você deseja analisar (lembre-se: para selecionar corrente clique nas 
caixas vermelhas, para selecionar tensão clique no fio), e clique em Esc. 
Automaticamente a janela Waveform Window abrirá com as formas de onda dos nós 
selecionados (figura A4.27). 

FIGURA A 4  27 - Análise transiente do Amplificador Miller 

A4.6 Criando o Layout 

Com o circuito validado via simulação elétrica (esquemático), o próximo passo é 
a descrição geométrica (layout) dos componentes do bloco a ser implementado. 

A partir do Library Manager, selecione o projeto em que você salvou o 
esquemático do circuito, clique em File->New-Xell View. Uma janela de criação de 



um novo arquivo abrirá. No campo Library Name deve estar configurada a biblioteca 
que você criou, no campo To01 escolha a opção Virtuoso, que automaticamente irá 
configurar o campo View Name para a opção layout. A figura A4.28 ilustra este 
procedimento. 
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FIGURA A 4  28 - Configurando o arquivo para a criação do layout de transistores do bloco a ser 
implementado 

I OK 

Então, uma janela do módulo Virtuoso abrirá para a edição de um layout. A 
janela LSW (Layer Select Window) também abrirá, com todos os layers da tecnologia 
AMSO.35prq previamente configurada na etapa de configuração da ferramenta. 

FIGURA A 4  29 - Virtuoso e LSW - Edição de layout 

~ancei  

O ambiente de trabalho do editor de layout Virtuoso é bastante similar aos vários 
editores disponíveis no mercado. Basicamente, basta clicar no layer desejado, 
selecionar no menu Create -> Rectangle, clique uma vez para fixar o primeiro ponto e 
uma segunda vez para fechar o retângulo. Clicando Esc você desabilita a ultima função 
requisitada. Utilizando as técnicas de layout descritas na seção 3.7 desta dissertação, 
pode-se iinplenieiitar a descrição geométrica do circuito. 

-7 '7 
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Com o circuito implementado, os pinos de entrada e saída do circuito devem ser 
criados. Clique em Create->Pin, escolha o nome, a direção do pino e o layer do nó 
desejado (figura A4.30). Clicando em Create->Label, você pode posicionar labels onde 
desejar. 
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FIGURA'A~.  30 - Configurando os pinos de entrada e saídado layout 

Então, pode-se obter o layout completo do amplificador Miller (com 
transistores, capacitor de compensação e pinos de entrada e saída), como é mostrado no 
exemplo da figura A4.3 1. 

FIGURA A 4  31 - Layout completo do amplificador Miller - Ambiente Virtuoso 

A4.6.1 Design Rule Check (DRC) 

Para a implementação do layout de um circuito, o projetista deve respeitar 
as regras de projeto da tecnologia usada (neste caso refere a tecnologia AMS0.35pmLm, 
previamente configuradas na etapa de configuração da ferramenta), como distâncias 
mínimas entre layers e comprimento mínimo do gate do transistor. Esta verificação, 



chamada de Design Rule Check JDRC) pode ser feita durante a edição do layout ou no 
final, como o projetista desejar. 

Para efetuar esta verificação selecione no menu Verfy -> DRC, a seguir uma 
janela de DRC abrirá (figura A4.32). O campo Checking Method deve estar 
configurado na opçãoflat, e no campo Checking Limit deve estar configurado na opção 
full. Verifique também se o arquivo com as regras de projeto está configurado, nos 
campos Rule file e Rule Library (divaDRC.ru1 e TECH - CSI, respectivamente). Clique 
em OK, e o DRC será iniciado. 

1 Join Netr Yilfh Same Name 

Checking Urnit full incrementa hy m a  

a,tin%iu! se1 hy airror 

1 Echo Comrnands 

Switch Names 11 

IOCU ternote M-nine 

FIGURA A4 32 - Configurando o DRC do layout 
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Se algum erro de projeto for acusado, na janela principal do icjh a mensagem # 
violated rules aparecerá, com as regras violadas. Para localizar os erros no layout, no 
menu Virtuoso clique em Verfy -> Markers -> Find. Quando não houver mais erros, 
na janela principal do icjh a mensagem O Total erros found aparecerá. 
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A4.6.2 Extração 

Com o layout do circuito pronto e as regras de projeto verificadas, o 
próximo passo é a extração elétrica do circuito, ou seja, todos os efeitos geométricos, 
incluindo-se os parasitas R, C e L extraídos do layout, são considerados. 

Para efetuar a extração, selecione no menu Verfy -> Extract, a seguir a janela 
Extractor abrirá (figura A4.33). O campo Extract Method deve estar configurado na 
opçãoflat, e no campo Switch Names deve estar configurado na opção capa11 (clique 
em Set Switches para selecionar esta opção). Verifique também se o arquivo com as 
regras de projeto está configurado, nos campos Rulefile e Rule Library (divaDRC.ru1 e 
TECH - CSI, respectivamente). Clique em OK, e a extração será iniciada. 
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FIGURA A 4  33 - Configurando a extração do layout 

Na janela principal do icjh a mensagem Extraction completed aparecerá, 
finalizando a extração. A seguir, pode-se visualizar o circuito extraído. A partir do 
Library Manager, clique no seu projeto e no campo View selecione a opção extracted 
(clicando com o botão esquerdo do mouse duas vezes). A figura A4.34 mostra a versão 
extraída do layout do amplificador Miller. 

FIGURA A 4  34 - Layout extraído do amplificador Miller A m b i e n t e  Virtuoso 

Portanto, agora o seu projeto tem quatro versões, ou seja, esquemático, símbolo, 
layout e extraído. O circuito está pronto para a simulação pós-layout. 



A4.7 Simulação pós-layout com o simulador elétrico Spectre 

Para a simulação elétrica das versões esquemático elétrico e layout extraído de 
um circuito é necessária a criação de um arquivo conjig. 

A partir do Library Manager, clique selecione o projeto que você criou para 
simulação elétrica do circuito. Clique em File->New->Cell View. Uma janela de 
criação de um novo arquivo abrirá. No campo Library Name deve estar configurada a 
biblioteca que você criou, no campo To01 escolha a opção Hierarchy-Editor que 
automaticamente irá configurar o campo View Name para a opção config (figura A4.35). 
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Automaticamente o ambiente Cadencea hierarchy editor abrirá. Na janela New 
Configuration (figura A4.36), no campo View: digite schematic, e depois clique em Use 
Template ... Ajanela Use Template abrirá, selecione a opção Spectre e clique OK. 
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FIGURA A 4  35 - Criando um arquivo cor?& para a sinulação de um circuito em versões diferentes 
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FIGURA A 4  36 Configurando o arquivo para a sinulação de um circuito em versões diferentes 

No hierarchy editor, no campo Top View o arquivo de simulação que você criou 
anteriormente para simular o esquemático pode ser configurado para a versão 
(esquemático ou layout extraído) que você desejar. Clique em View -> Tree. No 



campo Instante, todos os elementos que você adicionou no esquemático estarão 
presentes, como ilustra a figura A4.37. 

a Cadencen hierarchy editor: Neu Configuration A1 
I F i l e  Ed i t  View 5 Help I 

I Library L s t :  ) o y ~ # b  I 
pectre crnos.sch cnos.sch schematc u e r  Ioga ahdl I 

ectre cmos.sch c,"... 

c t r e  "mos-sch cm... 

RB (analagLib res  spectre) 

R1 (analagLib res  spectre> .ctre mos-sch cm... 

(analagLib "dc spectre> pectre cmos.sch c,"... 

udc spectre> spectre mos-sch cm... 

spectre cmos.sch c,"... 

V5 cana og i "si spectre mos-sch cm... 

I s e t  f k t h  a t  FRR 1252.227-19 or  equiualent. 
I 

I4 i 
u conf 8 gura- 
t o  open to, 
t o  aoen to, I ~ Created nem t o n .  

Rttempting i c e l l  uiew (Rmpl f.MiI 1er.smul II 1ler.simul schematic> f o r  edi t .  
Rttenipting , c e l l  uiew (Rmpl f - M i l  e r ~ s m u l  n I ler-simu1 schematic> f o r  edi t .  i 1 

FIGURA A 4  37 - hierarchy editor Configurando o arquivo para a sinulação 
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Selecione o componente que você deseja simular, clique com o botão direito 
do mouse e selecione a versão que você deseja acessar do circuito. Em select view, 
selecione a opção extracted, como ilustra a figura A4.38. 
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FIGURA A 4  38 - Selecionando a versão do o componente que você deseja sinular 

A partir do arquivo config, você pode simular as diversas versões do seu 
circuito, seguindo os mesmos passos da seção A4.5. Para melhor conveniência, você 
pode adicionar o seu projeto duas vezes e configurar um para versão esquemático e o 
outro para a versão extraída, como é ilustrado na figura A4.39. 
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FIGURA A 4  39 - As duas versões de um circuito em um mesmo arquivo de simulação 
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